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Zusammenfassung 
 

 

Heutzutage können Bilder mit verschiedener Software nahtlos aneinander gereiht 

werden und als navigierbares Panoramabild dargestellt werden. Eine Spezialform ist das 

Objectmovie, bei dem der Benutzer ein Objekt in alle Richtungen drehen und betrachten 

kann. Mehrere Panoramen verknüpft, ergeben einen virtuellen Rundgang, bei dem 

Bilder, Videos, Sound, Objectmovies und ähnliches integriert werden können. 

 

Diese Diplomarbeit befasst sich zunächst mit den verschiedenen Projektionsarten von 

Panoramen, darauf aufbauend werden die Produktionsmöglichkeiten aufgezeigt. Kurze 

Einblicke in die fotografische Aufnahmetechnik ermöglicht es zu verstehen, wie das 

Quellmaterial für das Zusammenfügen zu einem Panorama erzeugt werden kann. 

Anhand der Produktion eines virtuellen Rundganges und eines Objectmovies zeigt die 

Arbeit Vor- und Nachteile unterschiedlicher Software Lösungen auf und stellt diese 

gegenüber. In diesem Zusammenhang werden auch die möglichen Problembereiche 

dargestellt.  

Im Anschluss gebe ich einen Überblick über die gängigsten Viewertechniken und die 

dafür benötigten Plug-ins. 

Panoramabilder können vielfältig eingesetzt werden, auch dieses Thema wird behandelt, 

sowie mögliche zukünftige Anwendungsgebiete. Zuletzt wird die neuartige, sich im 

Vormarsch befindende Video VR Technik vorgestellt, mit der in einem 360°-Video 

navigiert werden kann. 
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Abstract 
 

 

Today it is possible to shoot overlapping pictures with a common digital camera and 

stitch them together with different software to get a navigatable, seamless panorama as 

a result. With an object movie, a special panorama type, the user may turn and watch an 

object in any position. Multiple panoramas result in a virtual tour, which can be combined 

with pictures, videos, sounds and object movies. 

 

This paper analyses the different types of panoramic projections and shows the 

possibilities of their production. Short insights in the photographic technologies will give 

you an understanding of how to combine source material to a complete panorama. With 

the production of a virtual tour, the paper values the different technologies by pros and 

cons of. Further some existing software products will be compared one to the other and 

possible problems will be shown. 

Afterwards an overview of the current viewer technologies and the necessary plug-ins 

will be given. 

 

Finally the application ranges of panoramic pictures today and in future will be explored. 

The last chapter deals with a new and promising method, the video vr technology, which 

gives the opportunity to navigate in a 360°-video. 

 

 

 

Matthias Nimpfer      St. Pölten, 16th July 2005 
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1. Einleitung 
 

Mit der Erfindung der digitalen Fotografie ist es nun möglich virtuelle Panoramen 

kostengünstig zu erzeugen. Vor allem im Webbereich sind sie ein beliebtes Interaktiv-

Feature und werden in unterschiedlichen Bereichen eingesetzt. Mit einer Digitalkamera 

aufgenommene Einzelbildern lassen sich mit verschiedenster Software zu einem 360° 

Panorama bzw. zu einem virtuellen Rundgang zusammensetzen. 

 

Es befindet sich eine unübersichtliche Anzahl von Verfahren zur Panoramabilderstellung 

am Markt. Die Softwareprodukte erfordern unterschiedliche Quellmaterialen und 

erzeugen Ergebnisse in verschiedenen Formaten und Qualitäten. Diese Formate 

wiederum erfordern für die Darstellung im Browser jeweils eigene Plug-ins. Im Rahmen 

der Diplomarbeit sollen die gängigsten Verfahren ausgetestet und die jeweiligen Vor- 

und Nachteile aufgezeigt werden. Unterschiedliche Anwendungsgebiete erfordern 

unterschiedliche Techniken, welche ebenfalls ausgetestet werden. 

 

Neben den herkömmlichen Darstellungen gibt es Innovationen, welche virtuelle 

Panoramen weiterentwickeln, so kann mit spezieller Hard- und Software ein virtuelles 

360°-Video produziert werden. Weiters bemühe ich mich das Zukunftspotential von 

Panoramadarstellungen aufzuzeigen. 



9 

2. Was ist ein Panorama? 
 

2.1 Geschichte 
 

Panorama (griechisch-lateinisch): "allschau" (vgl. Müller, 1972, S. 114) 

 

Panoramen übten schon immer eine Faszination auf die Betrachter aus. Bereits im 18 

Jahrhundert n. Chr. begannen Maler in kreisförmigen Räumen rundumlaufende Gemälde 

zu malen. Diese bis zu 15 Meter hohe, so genannte Rotunden, schlossen mit der Kuppel 

nach oben hin ab. Beliebte Motive waren vor allem Stadtansichten, Kriegsschauplätze 

und Ansichten von fernen Ländern. 

 

Mit der Erfindung der Fotografie im Jahr 1839 erhielt die Panoramadarstellung eine 

weitere Belebung. Bereits 1843 entwickelte der Österreicher Joseph Puchberger die 

erste Panoramakamera mit einem Blickwinkel von 150°. Von Kodak wurde diese Technik 

aufgegriffen und verbessert, so entstand 1899 das erste Serienprodukt, das Modell No. 

4. Die Technik wurde weiterentwickelt und es gibt heute Panoramakameras, die mit 

einem Drehmotor ein komplettes Panoramabild ablichten. (vgl. Jacobs, 2003, S. 1f) 

 

Die digitale Fotografie verdrängt jedoch immer mehr die technisch aufwendigen und 

teuren Panorama-Fotoapparate. Die Aufnahme von Einzelbildern und die nachträgliche 

Montage in ein Panorama lässt sich kostengünstig und leicht am eigenen Computer mit 

spezieller Software herstellen.  

 

Eine Weiterentwicklung von Panoramabildern stellen virtuelle Welten dar. Die Technik 

basiert auf der Verknüpfung von mehreren Panoramen. Diese Anwendungen vermitteln 

dem Benutzer das Gefühl, sich mitten in der dargestellten Szene zu befinden. Durch 

Interaktion kann der Benutzer sich durch ein oder mehrere Bilder bewegen. Marktführer 

in diesem Gebiet ist das Produkt Quick Time VR von Apple.1 
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2.2 Definition 
 

„Panoramabilder zeichnen sich durch die Abdeckung eines großen Betrachtungswinkels 

aus. Das entscheidende Kriterium dafür, ob ein Foto Panoramawirkung hat, ist der 

Bildwinkel, den das Motiv zeigt.“2 

 

Von Panoramaaufnahmen spricht man, wenn eine Fotografie einen Bildwinkel von 120 

Grad und mehr abdeckt, also ein Drittel des gesamten 360-Grad-Blickfeldes. 1 

Man unterscheidet zwischen Vollpanorama oder Rundbild (360° Panorama) und Teil- 

oder Partialpanorama (unter 360°). (vgl. Filodda, Henrichs, Wacker, 2003, S. 30) 

Eine Spezialform stellt das Kugelpanorama dar, mit dem das komplette Umfeld in Form 

einer Kugel dargestellt werden kann. 

 

Panoramabilder erlauben die Abbildung feiner Details bei einem großen horizontalen 

Sichtbereich. Sie werden oft für die Abbildung von Architektur und Landschaften 

herangezogen (vgl. Jacobs, 2003, S. 2) 

 

2.2.1 Produktion eines virtuellen Panoramas im Überblick 

 

Die Produktion eines virtuellen Panoramas läuft im Wesentlichen nach folgendem 

Schema ab: 
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Bild 1: Produktion eines virtuellen Panoramas 

 

• Aufnahme mit einer Kamera 

 

Die komfortabelste Lösung ist die Aufnahme mit einer speziellen 

Panoramakamera. Sie lichtet die komplette Kameraumgebung ab und für ein 

fertiges 360° Panorama müssen in der Regel nur die beiden Nahtkanten 

zusammengefügt werden. 

Ein anderer Weg ist die Aufnahme mit einem herkömmlichen Fotoapparat. Dabei 

werden Einzelbilder in gleichmäßigen Abständen fotografiert, die sich um einen 

gewissen Prozentsatz überlappen. Die so entstandenen Bilder müssen mit einer 
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speziellen Software nachträglich gestitcht (engl.: zusammenfügen) werden. Für 

die Erzeugung eines sphärischen (kugelförmigen) Panoramas sind mehrere sich 

überlappende Bildreihen erforderlich. 

 

Die meisten Abbildungen durch optische Objektive erzeugen kissen- oder 

tonnenförmige Verzeichnungen, Vignettierung oder chromatische Aberration. 

Daher ist es ratsam, diese Abbildungsfehler vor oder während des Stitchen mit 

geeigneter Software zu korrigieren. Zu stark verzerrte Bilder können unter 

Umständen nicht gestitcht werden. Einige Stitching-Programme lösen dieses 

Problem automatisch. 

 

• Stitchen 

 

Durch das Stitchen werden die Einzelbilder zu einem Panoramabild 

zusammengefügt. Die Bilder werden durch die Software in die richtige 

Perspektive projiziert und mittels markanter Punkte übereinander gelegt. Die 

Stitching-Software blendet meist die Überlappungsbereiche ineinander, um einen 

weichen und somit unsichtbaren Übergang zu schaffen. 

 

Falls erforderlich können am Panoramabild Farb- und Helligkeitsveränderungen 

vorgenommen werden. 

Bei der Erzeugung eines sphärischen Panoramas scheinen in der Regel im 

Bodenbereich die Füße des Stativs auf. Will man auch diesen Bereich 

authentisch erscheinen lassen, so sollte hier retuschiert werden. 

 

• Publikation im Web 

 

Für die Darstellung im Web über die so genannten Viewer stehen viele 

Möglichkeiten offen. Die gängigen Panorama-Exportformate sind Quicktime VR, 

Java, iPix, Hotmedia, VRML und Flash. Diese Viewer benötigen verschiedene 

Plug-ins. (vgl. Jacobs, 2003, S. 9ff) 
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2.3 Projektionsformen 
 

Um die erforderliche Raumkrümmung zu erzeugen, werden die Panoramabilder durch 

die Software einer bestimmten Projektion zugeführt, die eine realistische Darstellung 

gewährleistet. 

 

Bei der Panoramaproduktion werden 3 verschiedene Projektionsformen eingesetzt: 

• Zylindrisch 

• Sphärisch 

• Kubisch 

 

Demnach gibt es 3 verschiedene Ergebnisse von Panoramen: 

 

2.3.1 Zylindrische Panoramen 

 

Bei zylindrischen Panoramen wird der Himmel oder die Decke, sowie der Boden nicht 

auf dem Panorama abgebildet. Im horizontalen Blickfeld ist jedoch der volle Umfang von 

360° sichtbar.3 

Bei der zylindrischen Projektion wird das Panoramabild leicht gewölbt, dadurch bekommt 

das Panorama eine für den Betrachter realistischere Anmutung. Die zylindrische 

Darstellung eignet sich am besten für Motive, bei denen der untere und obere 

Bildausschnitt nicht so wichtig ist. (vgl. Jacobs, 2003, S. 5f) 

 

 
Bild 2: Zylindrische Projektion 

 

2.3.2 Sphärische Panoramen 

 

Im Gegensatz zu zylindrischen sind sphärische Panoramen im vertikalen 

Schwenkbereich nicht begrenzt und haben somit einen Abbildungsgrad von 360° x 180°. 
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Sie zeigen den kompletten Raum. Der Betrachter befindet sich optisch im Zentrum der 

Kugel.  

 

Bei der sphärischen Projektion wird die Verzerrung in horizontaler und vertikaler 

Richtung durch den jeweiligen Viewer korrigiert. 

Sphärische Panoramen eignen sich vor allem für Innenbereiche (z.B. Schlösser mit 

schönen Decken und Böden). (vgl. Jacobs, 2003, S. 6) 

 

 
Bild 3: Sphärische Projektion 

 

2.3.3 Kubische Panoramen 

 

Kubische Panoramen haben ebenfalls einen Abbildungsgrad von 360° x 180°. Hier wird 

auf einen Würfel projiziert. Die Technik, die der würfelförmigen Projektion zugrunde liegt, 

ist jedoch weniger aufwändig als die der sphärischen Projektion. Der Viewer verzerrt das 

Bild dahingehend, dass eine kantenlose Darstellung ermöglicht wird. Bei starkem 

Hineinzoomen ins Bild, sind jedoch gelegentlich die Kanten des Würfels sichtbar. (vgl. 

Jacobs, 2003, S. 7) 
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Bild 4: Kubische Projektion 

 

2.4 Spezialpanoramen 
 

2.4.1 Objectmovies 

 

Ein Objectmovie ist ein „umgekehrtes“ Panorama. Die fest installierte Kamera fotografiert 

das Objekt, das sich auf einem Drehteller befindet und gedreht wird. (vgl. Jacobs, 2003, 

S. 3) 

 

Es handelt sich somit um eine Art Film, bei dem verschiedene Ansichten rund um das 

Objekt hintereinander abgespielt werden. Die Einzelbilder sind als Bildstreifen so 

angelegt, dass der jeweils nächste Blickwinkel des Objekts dargestellt wird. So bekommt 

der Betrachter den Eindruck, er würde das Objekt selbst drehen und bei mehrreihigen 

Objectmovies auch neigen. (vgl. Jacobs, 2003, S. 127) 

 

2.4.2 Makro Panoramen 

 

Diese Spezialform von Panoramen will Rundumsichten von sehr kleinen Umgebungen 

darstellen, in denen kein Platz für herkömmliche Fotoapparatur wäre. Man behilft sich mit 

dem Trick eine kleine, spiegelnde Metallkugel in die Mitte des Mikroraumes zu legen und 
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von oben die Spiegelung abzufotografieren. Der Name Makro-Panorama leitet sich ab 

von der Makrofotografie, bei der kleine Gegenstände durch Nahaufnahmen vergrößert 

dargestellt werden. (vgl. Jacobs, 2003, S. 4) 

 

 
Bild 5: Makro-Panoramafotografie 

 

2.4.3 Virtuelle Rundgänge 

 

Hier sind mehrere Einzelpanoramen mit so genannten Hotspots verlinkt. Durch Klick auf 

einen solchen Hotspot in einem Panorama gelangt der Betrachter zur nächsten Stelle 

des Rundgangs. Aber nicht nur Panoramen selbst können verlinkt werden. Bei 

aufwändigen Projekten lassen sich Objectmovies, Videos, Sound und Grafiken 

integrieren. (vgl. Jacobs, 2003, S. 5) 
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3. Aufnahmetechniken 

 

3.1 Begriffsdefintionen 
 

Das Zentrum des Panoramas, der Standort des Betrachters, wird als Node (Nodalpunkt) 

bezeichnet. Das Panorama bildet ein, um den Node herum angeordnetes, zylindrisches 

Bild, einen dreidimensionalen Raum. 

 

 

Bild 6: Nodalpunkt eines Panoramas 

 

Für die Panoramafotografie können unterschiedliche Objektivtypen verwendet werden. 

Jedes Objektiv hat einen gewissen Bildwinkel, aus dem sich die erforderliche Anzahl an 

Einzelbildern für den Stitching Prozess ergibt. (vgl. Jacobs, 2003, S. 11) 

 

Der Bild- oder Blickwinkel beschreibt physikalisch gesehen, in welchem Winkel sich 

maximal Objekte befinden dürfen, damit sie gerade noch auf dem Film abgebildet 

werden. Ein großer Bildwinkel bedeutet, dass das Objektiv verkleinert. Ein kleiner 

Bildwinkel besagt hingegen, dass das Objektiv wie ein Fernrohr die Welt "näher 

heranbringt". 

Für die Panoramafotografie gilt allgemein, je größer der Blickwinkel, desto weniger 

Einzelbilder werden benötigt. 

 



18 

 
Bild 7: Objektivarten 

 

Objektive mit geringem Bildwinkel bezeichnet man als Teleobjektive und solche mit 

großem Bildwinkel als Weitwinkelobjektive. Objektive mit extrem großem Blickwinkel (bis 

zu 220°) werden Fisheye (Fischaugen-) Objektiv genannt. Das Standard Objektiv hat 

eine Brennweite von 50 mm, da diese der Brennweite des menschlichen Auges 

entspricht. 4 

 

 

Bild 8: Bildwinkel/Brennweite 

 

Bild- oder Blickwinkel a (picture angle) 

Brennweite f (focal length) 

 

Im Englischen wird der Bildwinkel „field of view“ (FOV) genannt. Der horizontale 

Bildwinkel (horizontal angle of view, HFOV) beschreibt die Ausdehnung der Abbildung in 
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horizontaler Richtung, der vertikale Bildwinkel (vertical angle of view, VFOV) die 

Ausdehnung in vertikaler Richtung. 

 

 

Bild 9: Bildwinkel, field of view (FOV) 

 

Kameraausrichtung hochkant (portrait): 

Horizontaler Bildwinkel (HFOV) = 2 x arctan (12 / Brennweite) 

Vertikaler Bildwinkel (VFOV) = 2 x arctan (18 / Brennweite) 

 

Kameraausrichtung quer (landscape): 

Horizontaler Bildwinkel (HFOV) = 2 x arctan (18 / Brennweite) 

Vertikaler Bildwinkel (VFOV) = 2 x arctan (12 / Brennweite) 

(vgl. Jacobs, 2003, S. 13ff) 

 

Die folgende Tabelle gibt die Blickwinkel unterschiedlicher Brennweite für 

Kleinbildkameras wieder. Die Angaben für die Brennwerte beziehen sich auf einen 

Schärebereich von unendlich. 
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Objekttyp Brennweite  Bildwinkel horizontal Bildwinkel vertikal 

Fisheye 6-8 mm 220-180° 220-180° 

Fisheye 15-16 mm 160-140° 160-140° 

Weitwinkel 17 mm 70° 93° 

Weitwinkel 20 mm 62° 84° 

Weitwinkel 24 mm 53° 74° 

Weitwinkel 28 mm 46° 65° 

Weitwinkel 35 mm 38° 54° 

Standard 50 mm 27° 40° 

Tele 80 mm 17° 25° 

Tele 120 mm 11° 17° 

Tele 200 mm 7° 10° 

Tabelle 1: Bildwinkel in Abhängigkeit der Brennweite 

 

3.2 Fotografie 
 

Schon bei der Aufnahme der Einzelbilder sollten einige grundlegende Punkte beachtet 

werden, um spätere, aufwändige Nachbearbeitungen der Bilder zu vermindern und den 

Stitchingprozess zu erleichtern. 

 

3.2.1 Überlappung / erforderliche Bildanzahl 

 

Damit die Software lückenlos die Einzelbilder kombinieren kann, ist eine gewisse 

Überlappung notwendig. Diese sollte etwa 20-50% betragen. Befinden sich bewegte 

Objekte im Aufnahmebereich, ist es sinnvoll eine höhere Überlappung zu wählen, da 

man im nachhinein diese leichter herausretuschieren kann. Wenn eine Person z.B. bei 

der ersten Aufnahme in der Bildmitte fotografiert wird, und sich bei der zweiten 

(weitergedrehten) Aufnahme im Bild wieder findet, sieht man im fertigen Panoramabild 

diese Person dann doppelt. In der Regel ist dies ein störender Faktor, kann jedoch bei 

speziellen Aufnahmen auch als Gestaltungsmittel verwendet werden. 5 

 

Anzahl der aufzunehmenden Bilder = 100 x A / (100 – B) x HFOV 

 

A … endgültiger Panoramabildwinkel 

B … Überlappung der einzelnen Bilder 
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HFOV … horizontal field of view (horizontaler Bildwinkel) 

 

Die folgenden beiden Tabellen geben einen Überblick über die erforderliche Bildanzahl. 

Dabei wird von Hochformataufnahmen ausgegangen. Der Panoramabildwinkel beträgt 

360°, die Überlappung 30°. (vgl. Jacobs, 2003, S. 18) 

 

Brennweite  Bildwinkel Bildanzahl Abstand zwischen den Bildern 

15 mm 100° x 77° 6 60° 

20 mm 84° x 62° 8 45° 

28 mm 65° x 46° 10 36° 

35 mm 54° x 38° 12 30° 

Tabelle 2: Erforderliche Bildanzahl für Singlerow-Aufnahmen 

 

Brennweite  Bildwinkel Bildanzahl Abstand zw. 

den Bildern 

Bildreihen 

15 mm 100° x 77° 14 60° 1 Bild +90° Neigung 

6 Bilder +30° Neig. 

6 Bilder -30° Neig. 

1 Bild +90° Neig. 

20 mm 84° x 62° 26 45° 1 Bild +90° Neigung 

8 Bilder +60° Neig. 

8 Bilder 0° Neig. 

8 Bilder -60° Neig. 

1 Bild -90° Neig. 

28 mm 65° x 46° 32 36° 1 Bild +90° Neigung 

10 Bilder +45° Neig. 

10 Bilder 0° Neig. 

10 Bilder -45° Neig. 

1 Bild -90° Neig. 

35 mm 54° x 38° 50 30° 1 Bild +90° Neigung 

12 Bilder +60° Neig. 

12 Bilder +20° Neig. 

12 Bilder -20° Neig. 

12 Bilder -60° Neig. 

1 Bild -90° Neig. 

Tabelle 3: Erforderliche Bildanzahl für sphärische Multirow-Aufnahmen 
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3.2.2 Belichtung 
 

Vor allem bei Motiven oder Szenen mit großen Helligkeitsunterschieden kann es 

vorkommen, dass bei eingestellter automatischer Belichtung die einzelnen Bilder 

unterschiedlich hell werden. Dies passiert vor allem dann, wenn sich ein Teil der Szene 

im Schatten und der andere im Sonnenlicht befindet. Beim Zusammenfügen entstehen 

so unerwünschte Helligkeitsabstufungen an den Stoßstellen der Einzelbilder. Manche 

Programme sind zwar in der Lage dies bis zu einem gewissen Grad zu korrigieren, doch 

bei den Nahtstellen wird es immer Probleme geben. Wenn die verwendete Kamera nicht 

in der Lage ist die Belichtungswerte (Blende und Verschlusszeit) anzupassen, wird dies 

unter Umständen zu Problemen führen. Eine Möglichkeit wäre in so einem Fall, bei 

Sonnenschein während der Mittagszeit zu fotografieren, da dann die Sonne am höchsten 

steht und die Umgebung gleich hell angestrahlt wird. 

 

Viele Kameras bieten aber die Möglichkeit, die Belichtung zu fixieren, was um einiges 

komfortabler ist. Bei der ersten Aufnahme werden die Belichtungsdaten gespeichert und 

für die folgenden Aufnahmen herangezogen. Das bedeutet jedoch gleichzeitig, dass bei 

Panoramen mit unterschiedlicher Ausleuchtung die erste Aufnahme in etwa dem 

Mittelwert der maximal oder minimal vorkommenden Helligkeit entsprechen soll. Das 

erste Foto sollte also nicht direkt im Schatten oder direkt im sonnenangestrahlten 

Bereich fotografiert werden, sondern etwa in der Mitte angesetzt werden. 

 

 
Bild 10: Helligkeitsunterschiede 

 

Was ebenfalls großen Einfluss auf die Qualität von Panoramen hat, ist der Weißabgleich. 

Auch wenn die Kamera die Belichtungswerte fixiert, muss das noch nicht für den 

Weißabgleich gelten. Ein unterschiedlicher Weißabgleich zwischen den Einzelbildern 
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sorgt für genau dieselben Probleme wie die unterschiedliche Belichtung. Mitunter sind 

solche Aufnahmen um einiges schwieriger zu korrigieren. 5 

 

3.2.3 Drehpunkt (Nodalpunktproblem) 

 

Ein weiteres optisches Phänomen, der Parallaxefehler, kann Probleme beim 

Zusammenrechnen verursachen. Dieser Fehler tritt auf, wenn der Brennpunkt des 

verwendeten Objektivs und der Drehpunkt der Kamera nicht genau übereinander liegen. 

Dann verschieben sich beim Weiterdrehen der Kamera Objekte am Bildrand zueinander. 

Dieser Umstand könnte beim Zusammenfügen der Einzelbilder große Probleme 

verursachen. Je näher dabei das zu fotografierende Motiv oder die Szene ist, desto 

stärker ist dieser Parallaxefehler. Ist das Motiv oder die Szene sehr weit entfernt, wie 

z.B. bei Landschaftspanoramen, wird er sich kaum auswirken. Einige wenige 

Kamerahersteller geben aus diesem Grund die Position des Objektivbrennpunkts, den so 

genannten Nodalpunkt an. Er ist bei einem Zoomobjektiv abhängig von der 

Zoomstellung, für Fixbrennweiten ist er fix. Für professionelle Aufnahmen gibt es 

Stativaufsätze zu kaufen, bei denen der Linsenbrennpunkt immer im Drehpunkt der 

Kamera bleibt. 5 

 

3.3 Zylindrische Panorama 
 

3.3.1 Singlerow-Technik 

 

Bei der Singlerow-Technik wird eine Reihe von Einzelbildern aufgenommen, die sich 

jeweils um einen bestimmten Prozentsatz überlappen. Für die Aufnahme können 

herkömmliche analoge oder digitale Fotoapparate verwendet werden. (vgl. Jacobs, 2003, 

S. 63f) 

 

 
Bild 11: Einzelbilder für die Singlerow-Technik 
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3.3.2 Multirow-Technik 
 

Hier werden eine Vielzahl, nicht nur in horizontaler, sondern auch in vertikaler Richtung 

aufgenommene Einzelbilder benötigt. Beginnend mit der Horizontreihe folgen mehrere 

sich überlappende Bildreihen. Abhängig von der Anzahl der Bildreihen können hier bis 

zu sphärische Panoramen entstehen. (vgl. Jacobs, 2003, S. 64f) 

 

 

Bild 12: Bilderreihen für die Multirow-Technik (zylindrisches Panorama) 

 

3.3.3 Panoramakameras 

 

Es befinden sich sowohl analoge (z.B. Seitz Roundshot 28/220), als auch digitale (z.B. 

Spheron VR) Panoramakameras am Markt. Je nach verwendetem Objektiv ergibt sich 

ein dementsprechender vertikaler Bildwinkel. 

In beiden Fällen bewegt sich die Kamera mittels eines Rotors 360° um die eigene Achse 

und nimmt somit in einem Schritt das gesamte Panorama auf. (vgl. Jacobs, 2003, S. 59f) 

 

  

Bild 13: Panoramakameras 
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3.3.4 One-Shot-Lösungen mit Parabolspiegel 
 

Diese gekrümmten Spiegel werden meist mit einem Adapter auf das jeweilige Objektiv 

aufgesetzt und ermöglichen mit einer einzigen Aufnahme eine komplette 

Rundumansicht. Der horizontale Blickwinkel ist jedoch mit max. 100° begrenzt. Hier wird 

nur ein Bild im kreisrunden Format aufgenommen. Das entstandene Bild ist stark verzerrt 

und muss mit spezieller Software (z.B. PhotoWarp) entzerrt werden, so dass ein 

zylindrisches Panorama entsteht. (vgl. Jacobs, 2003, S. 61f) 

 

Bild 14: One-Shot-Lösung mit Parabolspiegel 

 

 
Bild 15: Parabolspiegel Aufnahme 
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3.4 Sphärische und kubische Panoramen 
 

3.4.1 Singlerow-Technik 

 

Durch Verwendung von zwei Fisheye-Bildern, die jeweils einen 180° Blickwinkel 

abdecken, kann ebenfalls der gesamte sphärische Bereich aufgenommen werden. Diese 

Technik ist relativ unkompliziert und auch bewegte Objekte stellen kein Problem dar, 

solange sie sich nicht im Randbereich befinden. Um mehr Überlappung für das 

anschließende Stitchen zu haben, können auch vier Fisheye-Bilder verwendet werden. 

(vgl. Jacobs, 2003, S. 101f) 

 

   
Bild 16: Fisheye-Aufnahmen 

 

3.4.2 Multirow-Technik 

 

Hier wird eine Vielzahl von sich überlappenden Einzelbildern verwendet. Es werden so 

viele Bildreihen benötigt, bis der gesamte sphärische Bereich abgedeckt ist. Für diese 

Aufnahmen ist ein Stativkopf notwendig, der eine Justierung in horizontaler und vertikaler 

Richtung zulässt. (vgl. Jacobs, 2003, S. 103f) 
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Bild 17: Bilderreihen für die Multirow-Technik (sphärisches/kubisches Panorama) 

 

3.4.3 Panoramakameras 
 

Es gibt sowohl analoge Panoramakameras, die meist auf zylindrische Panoramen 

begrenzt sind, als auch digitale Panoramakameras, die auch sphärische Aufnahmen 

liefern. 

 

Digitale Panoramakameras (z.B. Seitz Roundshot Super Digital II) besitzen einen RGB-

Zeilensensor. Während der Aufnahme dreht sich die Kamera mittels Motor um die 

eigene Achse und kann somit die komplette Kameraumgebung aufnehmen. Die meisten 

digitalen Panoramakameras funktionieren nur in Kombination mit einem Notebook. Eine 

spezielle Roundshot-Software steuert die Kamera und speichert die Bildinformationen. 

Aufgrund der Scantechnik kann es bei bewegten Objekten zu störenden Verzerrungen, 

in Form von breiten Farbstreifen, kommen. Bei direkt einfallendem Sonnenlicht kann ein 

weißer Streifen entstehen, das so genannte Blooming. (vgl. Jacobs, 2003, S. 93ff) 
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Bild 18: Seitz Roundshot Super Digital II 

 

3.5 Objectmovies 
 

3.5.1 Singlerow-Technik 

 

• Aufnahme mittels Drehteller 

 

Auf horizontaler Ebene ist die Drehung des Objekts um 360° möglich. Das 

Schwenken nach unten und oben ist mit der Singlerow-Technik nicht realisierbar. 

Zur Aufnahme wird das Objekt mittig auf einem Drehteller positioniert, der für 

jedes Foto um eine bestimmte Gradzahl weiterbewegt wird. Die Kamera bleibt für 

die komplette Bildreihe statisch positioniert. 
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Bild 19: Roundshot VR-Drive mit Drehteller-Aufsatz 

 

• Walk Around 

 

Für Objekte, die nicht bewegt werden können, bietet sich die Walk Around 

Methode an. In diesem Fall bleibt das Objekt still stehen und der Fotograf bewegt 

sich in einem gewissen Abstand um das Objekt. Voraussetzung ist, dass eine 

exakte Kreisbewegung in immer der gleichen Höhe durchgeführt wird. Es 

empfiehlt sich ein Stativ mit Wasserwaage zu verwenden und bei jeder Aufnahme 

die Kamera exakt auszurichten. Für die Einhaltung des Radius bietet sich der 

Einsatz eines Seiles als Hilfsmittel an, das ähnlich wie ein Zirkel um das Objekt 

herumbewegt wird. (vgl. Jacobs, 2003, S. 127ff) 

 

3.5.2 Multirow-Technik 

 

Bei einem Multirow-Objectmovie kann das Objekt vom Betrachter neben der horizontalen 

Drehung auch vertikal bewegt werden. Abhängig von der Anzahl und Ausrichtung der 

Bildreihen kann eine komplette Drehung des Objekts in alle Richtungen erzielt werden. 

Die Aufnahme solcher Movies gestaltet sich wesentlich aufwändiger, als die Singlerow-

Technik. Es wird eine Vorrichtung benötigt, mit der sich die Kamera in immer gleichem 

Abstand zum Objektmittelpunkt um das Objekt schwenken lässt. Nach der Aufnahme der 

ersten Reihe, die meist mit 0° vertikal aufgenommen wird, wird die Kamera um 

beispielsweise 30° vertikal nach oben geschwenkt. So kann die zweite Bildreihe 
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aufgenommen werden. Für ein komplettes Multirow-Objectmovie werden bei einem 30° 

vertikalen Abstand 7 Bildreihen zu je 36 Bildern benötigt. (vgl. Jacobs, 2003, S. 128ff) 

 

 
Bild 20: Multirow-Objectmovie Aufnahmen 
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4. Stitching Technik 
 

4.1 Grundlagen 
 

Nach der Aufnahme der Quellbilder ist der nächste Schritt das Stitchen, also das 

Zusammenfügen der aufgenommenen Einzelbilder zu einem Panoramabild.  

Die Stitching-Software sucht zunächst in den beiden Einzelbildern korrespondierende 

Punkte, anhand dessen die Bilder deckungsgleich übereinander gelegt werden. 

 

Was das händische Zusammenfügen schwierig machen würde, ist dass viele Objektive 

Verzerrungen haben, die über das Bild verteilt sehr unterschiedliche Auswirkungen bzw. 

Stärke haben. Die Panoramasoftware muss also das Bild nicht nur drehen oder 

schieben, sondern auch wölben und spätestens hier steht man händisch in einem 

Bildbearbeitungsprogramm vor Schwierigkeiten. Die Software projiziert die Einzelbilder 

schon beim Definieren der Überlappungskanten in die richtige Perspektive, dadurch wird 

das Positionieren der Einzelbilder im Gesamtpanorama erleichtert. Die Parameter für die 

Projektion ergeben sich aus den Aufnahmewerten, wie dem verwendeten Objektiv, dem 

Abstand und der Anzahl der Einzelbilder.  

 

Die letzte Aufgabe der Panoramasoftware ist das Überlenden, also die Transparenz der 

überlappenden Bereiche so einzustellen, dass diese Stoßstellen nicht mehr oder nur 

minimal sichtbar sind. 

 

Drei Grundaufgaben gilt es somit für die Software zu bewältigen:  

• Korrespondierende Punkte in den Bildern festlegen 

• Bildkorrekturen 

• Stoßstellen wegblenden 

(vgl. Jacobs, 2003, S. 10) 
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4.2. Software Technologien 
 

4.2.1 Korrespondierende Punkte in den Bildern festlegen 

 

Pro zwei Bilder benötigt die Software mindestens 3 Kontrollpunkte (6 Einzelpunkte). Die 

meisten Programme arbeiten jedoch mit mehr Punkten und setzten diese pixelgenau in 

beide Bilder. Somit wird eine höhere Sicherheit gewährleistet. Ist man mit dem 

Endergebnis nicht zufrieden bieten manche Software Produkte auch die händische 

Nachjustierung dieser Stitching-Punkte an. 

 

4.2.2 Bildkorrekturen 

 

Wenn man die Aufnahmen mit einer Standard Kamera (50 mm Brennweite) macht, 

lassen sich die Einzelbilder mit den meisten am Markt befindlichen Stitching 

Programmen zusammenfügen. Verwendet man ein Weitwinkelobjektiv, um die Anzahl 

der Einzelbilder zu reduzieren, empfiehlt es sich Stitching Programme zu verwenden, die 

die Verzerrungen der Linse korrigieren können. 

 

 
Bild 21: Tonnenförmige, keine, kissenförmige Verzerrung 

 

Die Entzerrung ist ein sehr wichtiger Punkt, um gute Stitching Ergebnisse zu erzielen. 

Dabei deformiert oder verformt das Programm die Bilder bevor die Einzelbilder 

übereinander gelegt werden.  

 

Bei den meisten Stitching-Programmen hat man die Möglichkeit die 

Objektiveigenschaften, wie Brennweite und Bildwinkel einzustellen. Diese Informationen 

nutzt das Programm, um den Entzerrungsprozess zu beschleunigen und verbessert die 
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Exaktheit der Stitching-Kanten. Manche Programme errechnen sich aus dem 

Quellmaterial automatisch die verwendeten Objektiveigenschaften. 

Apple’s Authoring Studio unterstützt diese Aufgabe, indem es eine Reihe von 

Einstellungen auf zwei folgende Abbildungen durchtestet. Die beste Übereinstimmung 

der Kantendetails wird als neue Objektiveigenschaften genommen. 

Andere Programme, wie der Realviz Stitcher, verwenden eine mehr automatisierte 

Vorgehensweise. Die Software schätzt die Eigenschaften jedes hinzugefügten Bildes 

und korrigiert kontinuierlich mit jedem Schritt die Kantendetails. 

 

4.2.3 Überblenden 

 

Besonders bei Bildern mit unterschiedlicher Helligkeit ist es wichtig, die 

Überlappungsbereiche ineinander zu überblenden, da sonst die Nahstellen sichtbar sind. 

Die meisten Stitching Programme führen dies automatisch aus. (vgl. Andrews, 2003, S. 

70) 
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5. Publikation im Web 
 

Für die Darstellung im Web, über so genannte Viewer, stehen viele Möglichkeiten offen.  

 

5.1 Quicktime VR 
 

Die wohl verbreiteste Lösung ist die Quicktime Virtual Reality Technologie. QTVR ist 

eine Erweiterung von Apples Quicktime-Technologie, die plattformunabhängig (Win / 

MAC) in allen gängigen Browsern dargestellt werden kann. 

Der Benutzer kann mit Hilfe von Maus und Tastatur eine interaktive, fotorealistische, 

virtuelle Welt durchwandern. Millionenfach wurde die Quicktime Technologie auf 

Computern in der gesamten Welt (vor-) installiert und gehört somit zu der am weitest 

verbreitetsten Multimedia-Plattform der Computer-Welt. 

Seit Januar 1997 ist QTVR integraler Bestandteil von Quicktime. Um einen Quicktime 

Film auf dem Rechner betrachten zu können, muss der Quicktime Player installiert sein 

(Download unter: http://www.apple.com/quicktime/download/). Für einen, in einer HTML 

Seite eingebundenen Film benötigt man das Quicktime Plug-in, welches kostenlos zum 

Download bereit steht. Die Installationsdatei ist ca. 500 kB groß. (vgl. Jacobs, 2003, S. 

165f, 197) 

 

Ein Quicktime Film besteht aus mehreren Spuren. Jede dieser einzelnen Spuren 

referenziert eine einzelne Mediendatei, die Bezüge auf Filmdaten enthält. Unabhängig 

davon, ob ein Quicktime Film linear ist oder nicht, interaktiv oder nicht, ist er 

beschreibbar als ein Gefäß, welches vielerlei multimediale Daten enthalten kann. 

Verschiedene Datenformen werden gespeichert auf Spuren, die Apple „Tracks“ nennt. 

 

Die wichtigsten Tracks sind: 

• Ein Video Track beinhaltet, als Standard Track für visuelle Daten, in Quicktime 

Filmen einzelne Bilder oder Bildsequenzen. 

• Ein Sound Track ist die Standard Spur für digitalisiertes Audiomaterial. 

• Ein Musik Track enthält Musikinformationen, die Quicktime analog MIDI (Musical 

Instrument Digital Interface) behandelt, einem Standard in der elektronischen 

Musikindustrie. 
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• Ein Text Track beinhaltet nur Text. Diesen können Benutzer auf Stichworte 

abfragen, die sie präzise an bestimmte Stellen des Films bringen. Hier können 

auch URLs eingegeben werden, die an einem Punkt der Wiedergabe eine 

bestimmte Website aufrufen. 

• Ein 3D Track beinhaltet 3D Informationen. Dies können beispielsweise 

geometrische Objektdefinitionen, Oberflächenbeschreibungen oder Angaben 

über die Oberflächenstruktur von 3D Objekten sein. 

• Ein Tween Track birgt die Daten zur Steuerung von Objektbewegungen. Er 

arbeitet eng mit dem 3D Track zusammen. 

• Ein Sprite Track enthält grafische Objekte (Sprites). Diese sind entweder pixel- 

oder vektorbasierend, oder können auch 3D Informationen beinhalten. Manche 

Sprites beinhalten interaktive Schaltflächen, die ein bestimmtes Ereignis 

auslösen. 

• Hint Tracks sind Hinweisspuren, die einen Server veranlassen, Filmdaten über 

ein Netzwerk zu schicken. Sie kommen beim Streaming zum Einsatz. 

 

Ein Quicktime Film kann demnach viele Spuren enthalten, verschiedene Spurtypen oder 

auch multiple Spuren eines Typs. (vgl. Filodda, Henrichs, Wacker, 2002, S. 19f) 

 

Quicktime bietet im Vergleich zu anderen Viewern eine qualitativ hohe Bilddarstellung, 

diese ist einstellbar über den Kompressions-Codec. Das Panorama ist gut navigierbar 

und die Mousebewegungen werden exakt umgesetzt. 

 

Beim QTVR Export ist es möglich einzustellen, dass beim Laden des Movies bereits das 

gesamte Panorama navigierbar ist, das Bild jedoch zunächst unscharf gezeigt wird. Je 

mehr Bildinformationen geladen werden, desto detaillierter wird das Bild. Dadurch fällt 

dem Benutzer der Wartevorgang leichter, weil er sich bereits mit dem Panorama 

beschäftigen kann. Bei Objectmovies wird zu Beginn das erste Bild geladen. Erst wenn 

alle Informationen downgeloadet sind, kann der Benutzer einen 360° Schwenk 

durchführen. (vgl. Jacobs, 2003, S. 197) 

 

5.1.1 Kompression 

 

Wenn man Panoramen fürs Web produzieren möchte, ist die Art der Kompression ein 

entscheidender Faktor, da im Internet die Bandbreite der Übertragung begrenzt ist. Die 
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Kompression reduziert die Mediendaten, der Speicherbedarf wird geringer, und die 

Daten lassen sich schneller laden. Die interaktiven Reaktionszeiten eines QTVR Film 

werden zudem verbessert. 

Durch die Wahl der Datenrate lässt sich die Videoqualität für das Zielmedium einstellen. 

Während für Publikationen auf CD-Rom eine ungefähre Datenrate von 200 KB/Sekunde 

anzuraten ist, wählt man für Web Anwendungen weit niedrigere Raten. In Abhängigkeit 

von der Verbindungsgeschwindigkeit, über die die Zielgruppe verfügt, liegt das Maximum 

eher bei 50 kB/Sekunde. Bei sehr langsamen Modems kann im Grenzfall eine Datenrate 

von nur 1,5 kB/Sekunde sinnvoll sein. Der am häufigsten auftretende Fehler beim 

Komprimieren liegt in der Entscheidung für eine zu hohe Datenrate. 

 

Die verlustfreie Kompression macht eine Datei kompakter, enthält dabei aber alle Daten. 

Die verlustbehaftete Kompression hingegen beseitigt einige Informationen aus der 

behandelten Datei. Die meisten Bild- und Audiodaten enthalten mehr Details, als 

menschliche Augen und Ohren wahrnehmen können. Je mehr dieser Details die 

verlustbehaftete Kompression eliminiert, desto geringer wird die Dateigröße. Mit 

zunehmender Kompression macht sich jedoch eine Qualitätsminderung bemerkbar. 

 

5.1.2 Gängigste Kompressionsverfahren (Codecs) 

 

• Animation: Dieser Codec ist gut für Animationen und am Computer gefertigte 

Bilder geeignet, weniger für digitale Videos. Die Stärken liegen in der zeitlichen 

Komprimierung. Im Internet erreicht er nur bei Diashows akzeptable Datenraten. 

Da er alle Farbtiefen unterstützt, ist er für Filme mit einem Alphakanal 

verwendbar. 

 

• BMP: Das Format ist im Windows-Umfeld sehr verbreitet, geht aber mit großen 

Daten einher. Für Internetanwendungen ist BMP daher weniger geeignet und 

wird nur für den Import von Bitmap-Bildern benötigt. 

 

• Cinepak: Der heute am weitesten verbreitete Kompressor Cinepak wird vor allem 

dort eingesetzt, wo eine hohe Kompressionsrate und eine schnelle Wiedergabe 

gefordert sind. Die Videoqualität ist nicht so gut wie bei manchen anderen 

Codecs, die Geschwindigkeit in der Dekomprimierung ist jedoch eine der 

höchsten. Die Performance im Internet ist eher durchschnittlich, aber in der 
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Bereitstellung von Dateien auf CD-Rom ist er sehr gut. Er unterstützt Millionen 

Farben, 256 Farben und Graustufen. 

 

• Component Video: Dieser Codec komprimiert im Verhältnis 3:2 mit kaum 

wahrnehmbaren Qualitätseinbussen. Er arbeitet mit dem YUV-Farbraum, dabei 

erfolgt eine Differenzierung in die Luminanz und die Farbinformationen. Man 

kann ausschließlich die Datenrate einstellen, daher eignet er sich hauptsächlich 

für die Aufnahme und Archivierung als für Internet Anwendungen. 

 

• Photo JPEG: Dieser Codec benutzt den verlustbehafteten JPEG-Algorithmus zur 

Bildkompression. Er unterstützt 24-Bit Farbe und 8-Bit Graustufen und bietet eine 

sehr gute Performance in Qualität, Dateigröße und Wiedergabe. In den Bildern 

gibt es eine Reihe von Artefakten und unsauberen Rändern, dennoch ist der 

Codec für das Internet gut geeignet. Photo JPEG dekomprimiert langsamer als 

die meisten anderen Verfahren, deshalb ruckelt die Wiedergabe bei sehr 

langsamen Prozessoren. Ein Objektfilm verhält sich mitunter schwerfällig. 

 

• Graphics/Grafik: Dieser Codec ist geeignet für Animationen. Er ist eine gute 

Alternative, wenn man hohe Kompression, bei jedoch langsamer Dekompression 

benötigt. 

 

• Sensoren Video: Der Codec Sensoren Video liefert bei geringen Datenraten 

eine hervorragende Bildqualität. Der Codec ist wohl die beste Wahl für Video im 

Internet. Er arbeitet mit dem YUV-Farbraum und komprimiert sehr langsam. Bei 

einer Datenrate von 100 kB/Sekunde liefert Sensoren eine bessere Darstellung 

als Cinepak bei 300 kB/Sekunde. 

 

• Video: Der Codec Video ist ein alter Quicktime Kompressor von Apple. Er macht 

Sinn bei Objectmovies und insbesondere, wenn der Zielrechner recht langsam 

arbeitet oder eine alte Quicktime Version installiert ist. Für Panoramen ist er 

jedoch weniger geeignet. Nichts desto trotz kann man ihn einsetzen, um 

Arbeitsergebnisse zu überprüfen, da eine schnelle Wiedergabe bei 

durchschnittlicher Bildqualität gegeben ist. (vgl. Filodda, Henrichs, Wacker, 2002, 

S. 60ff) 
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5.1.3 Einbindung in HTML 
 
Will man das QTVR Movie in ein HTML Dokument einbetten, so gilt es zu beachten, 

dass es bei Verwendung des netscapespezifischen EMBED Tags im Internet Explorer in 

den Versionen 5.5 und 6.0 zu Kompatibilitätsproblemen kommt. Die Alternative ist das 

OBJECT Tag, dass jedoch ältere Netscape Versionen (4.x) nicht kennen. Somit macht 

es Sinn beide Tags im Quellcode zu verwenden. (vgl. Jacobs, 2003, S. 167f) 

 

Folgendes Beispiel zeigt die Einbindung eines QTVR Movies in ein HTML Dokument: 

 

<OBJECT 

classid="clsid:02BF25D5-8C17-4B23-BC80-D3488ABDDC6B" 

width="400" 

height="316"   

codebase="http://www.apple.com/qtactivex/qtplugin.cab"> 

<param name="src" value="panorama.mov"> 

<param name="autoplay" value="true"> 

<param name="controller" value ="true"> 

<param name="type" value="video/quicktime"> 

<param name="pluginspage" 

value="http://www.apple.com/quicktime/download/index.html"> 

<EMBED 

width="400" 

height="316" 

src="panorama.mov" 

type="video/quicktime" 

autoplay="true" 

controller="true" 

pluginspage="http://www.apple.com/quicktime/download/index.html"> 

</EMBED> 

</OBJECT> 

 

Das QTVR Movie ist in diesem Fall 400 x 300 Pixel groß. Will man den Quicktime 

Controller eingeblendet haben, so muss man zur Höhe noch 16 Pixel hinzurechnen. 6 
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Quicktime ist in der Lage im gleichen Player Panoramen, Videos und Sounds 

abzuspielen. Will man z.B. einen Soundloop im Hintergrund eines Panoramas laufen 

lassen, ist folgender Code zusätzlich zu verwenden: 

 

<OBJECT  

classid="clsid:02BF25D5-8C17-4B23-BC80-D3488ABDDC6B" 

hidden 

codebase="http://www.apple.com/qtactivex/qtplugin.cab"> 

<param name="src" value="soundloop.mov">  

<param name="autoplay" value="true"> 

<param name="controller" value ="false"> 

<param name="cache" value ="true"> 

<param name="loop" value ="true"> 

<EMBED 

src=”sound.mov” 

hidden 

autoplay=”true” 

controller=”false” 

cache=”true” 

loop=”true” 

pluginpage="http http://www.apple.com/quicktime/download/index.html "> 

</EMBED> 

</OBJECT> 

 

Die Sounddatei muss im Quicktime Format (*.mov) sein. Nachteil dieser Lösung ist, dass 

der Benutzer den Sound nicht stoppen kann. (vgl. Jacobs, 2003, 168f) 

 

5.2 Java-Lösungen 
 

Für Java basierende Viewer wird zwar kein Extra-Plug-in benötigt, jedoch muss Java 

installiert und im Browser aktiviert sein. Ab der Version Windows XP ist dies nicht mehr 

automatisch gegeben. Die aktuelle Java Version steht unter folgender Adresse zum 

Download bereit: „http://java.sun.com/getjava/de“. Die Installationsdatei ist ca. 10 MB 

groß.  
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Die Java Anwendung wird in einen Bytecode übersetzt und von einem Interpreter 

ausgeführt. Der große Nachteil ist, dass besonders rechenintensive Anwendungen, wie 

Panorama Darstellungen, viel Rechnerleistung erfordern. Besonders bei langsamen 

Prozessoren macht sich dies bemerkbar. Die Mausbewegungen können nicht so schnell 

umgesetzt werden, wie bei den Plug-in Lösungen. 

 

Im Weiteren wird nun der PTViewer behandelt. 

 

Der PTViewer ist ein JavaApplet, das Panoramabilder und Objectmovies (siehe 5.2.3) im 

Web darstellen kann. QTVR Movies können ebenfalls abgespielt werden, ohne dass das 

Quicktime Plug-in installiert ist. Hierfür wird die Erweiterung PTMViewer verwendet. 

Voraussetzung für die Verwendung des PTViewers ist, dass Java installiert und aktiviert 

ist.  

Bei jedem Aufruf der Website muss zusätzlich zur Bilddatei das 35 kB große PT-Viewer-

Applet downgeloadet werden. Erst wenn das Applet vollständig geladen ist, werden die 

Bildinhalte angezeigt und es lässt sich im Panorama navigieren. (vgl. Jacobs, 2003, 

169ff, 197f) 

 

5.2.1 Einbindung in HTML 

 

Parameter des Java Applets PT Viewer: 

• Width: Breite des Panoramafensters in Pixel  

• Height: Höhe des Panoramafensters in Pixel  

• File: Name des Panoramabildes, das mittels PTViewer dargestellt werden soll 

• Pan: Horizontale Drehposition beim Start des Panoramas. Werte von -180 bis 

+180 Grad sind möglich. Wird dieser Parameter nicht aufgeführt, ist der 

Drehwinkel automatisch null. 

• Tilt: Vertikale Drehposition beim Start des Panoramas. Werte von -90 bis +90 

Grad sind möglich. Wird dieser Parameter nicht aufgeführt, ist der Drehwinkel 

automatisch null. 

• Fov: Zoomfaktor beim Start des Panoramas. Werte von 12 bis 165 sind möglich. 

Wird dieser Parameter nicht angeführt, ist der Zoomfaktor automatisch 70. 

• Fovmin: minimaler Zoomfaktor; Werte von 12 bis 165 sind möglich. Der 

Standardwert bei nicht Anführen ist hier 12. 
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• Fovmax: maximaler Zoomfaktor; Werte von 12 bis 165 sind möglich. Der 

Standardwert bei nicht Anführen ist hier 165. 

• Panmax: maximaler, horizontaler Drehbereich; Werte von 0 bis 180 Grad sind 

möglich. 

• Panmin: minimaler horizontaler Drehbereich; Werte von 0 bis -180 Grad sind 

möglich. 

• Tiltmin: minimaler vertikaler Schwenkbereich; Werte von -90 bis 0 Grad sind 

möglich. Der Standardwert bei nicht Anführen ist -90 Grad. 

• Tiltmax: maximaler vertikaler Schwenkbereich; Werte von 90 bis 0 Grad sind 

möglich. Wird dieser Wert nicht angeführt, so wird automatisch 90 Grad 

genommen. 

• Wait: Es besteht die Möglichkeit ein JEPG oder GIF Vorschaubild einzubinden, 

das während der Ladezeit angezeigt wird. 

• Auto: Ist der Auto-Parameter aktiv beginnt das Panorama beim Start automatisch 

zu rotieren. Es sind Werte von -360 bis +360 möglich, wobei negative Werte eine 

Drehung nach links und positive Werte eine Drehung nach rechts bedeuten. 

 

Im folgenden Beispiel wird ein Panoramabild im JEPG Format mit dem PTViewer in eine 

HTML Datei integriert: 

 

<APPLET  

name=ptviewer  

archive=ptviewer.jar  

code=ptviewer.class  

width=400  

height=300> 

<param name=”file” value=”panorama.jpg”> 

<param name=pan value=”45”> 

<param name=tilt value=”50”> 

<param name=fov value=”80”> 

<param name=fovmin value=”30”> 

<param name=fovmax value=”120”> 

<param name=auto value=”0.5”> 

</APPLET> 
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Die Dateien „panorama.jpg“ und „ptviewer.jar“ müssen im selben Verzeichnis wie die 

HTML Datei liegen. (vgl. Jacobs, 2003, 170ff) 

 

5.2.2 Virtuelle Rundgänge 

 

Im PTViewer Applet lassen sich Hotspots definieren. Man kann somit mehrere 

Panoramen zu einem virtuellen Rundgang verlinken. 

 

Relevante Parameter für die Verlinkung von Hotspots: 

• File: definiert das Panorama, das zu allererst geladen wird. 

• Preload: Hier wird die Ladereihenfolge der Panoramen festgelegt. 

• <param name="hotspot0" value="x-22.83 y-48.66 i'hotspot.gif ' q n'Text in der 

Statuszeile' u'ptviewer:newPanoFromList(1)' '">: 

über die x und y Werte bestimmt man eine 24x24 Pixel große Kreismarkierung. 

Will man eine eigne Grafik verwenden, so geschieht dies über i'hotspot.gif '. Soll 

der Hotspot den Namen des Zielpanoramas angeben, so steht dies in 

Hochkomma nach dem „n“. Der Parameter „q“ legt fest, dass der Hotspot ständig 

sichtbar ist. Nach dem Parameter „u“ wird in Hochkomma die Zieldatei definiert. 

Diese kann direkt über den Dateinamen oder über die Funktion „PanoFromList()“ 

angesprochen werden. Die Ziffern in Klammern definieren welches Panorama 

(hotspot0, hotspot1, …) in das Viewer Fenster geladen wird. (vgl. Jacobs, 2003, 

172ff) 

 

Das folgende Beispiel zeigt eine Verlinkung von zwei Panoramen7: 

 

<APPLET name="ptviewer" archive=ptviewer.jar code=ptviewer.class width=160 

height=120> 

<param name=file value="panorama.jpg"> 

<param name="preload" value="panorama2.jpg" > 

<param name="hotspot0" value="x-22.83 y-48.66 i'hotspot.gif ' q n'Text der in der 

Statuszeile angezeigt wird' u'ptviewer:newPanoFromList(1)' '"> 

<param name=pano0 value= " {file=panorama.jpg} 

{hotspot0=x-22.83 y-48.66 cFFD700 q n'Hotspot zu Pan2' 

u'ptviewer:newPanoFromList(1)}"> 

<param name=pano1 value=" {file=panorama2.jpg}  
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{hotspot0=x-66 y-51 q i'hotspot.gif' n'Hotspot zu Pan1' 

u'ptviewer:newPanoFromList(0)'}"> 

</APPLET> 

 

5.2.3 Objectmovies 

 

Mit dem PTViewer können auch Objectmovies dargestellt werden. Das 

Ausgangsmaterial muss ein Bildstreifen des Objekts sein, der mit dem Programmtool 

„PTStripe“ erzeugt werden kann. 8 

 

Relevante Parameter für das Java Applet PTObject: 

• file: Name des Objektbildstreifens 

• nhor: Anzahl der Einzelbilder auf horizontaler Ebene 

• nver: Anzahl der Einzelbilder auf vertikaler Ebene 

 

Beispiel für die Objectmovie Darstellung über den PTViewer: 

 

<APPLET 

name=ptviewer 

archive=ptviewer.jar 

code=ptviewer.class 

width=400 

height=300> 

<param name=”applet0” value=” 

{code=ptobject.class} 

{file=objekt.jpg} 

{nhor=36} 

{nver=1}”> 

<param name=”inits” value=”ptviewer:startApplet(0)”> 

</APPLET> 

(vgl. Jacobs, 2003, S. 174ff) 
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5.3 iPIX 
 

Für die Darstellung von iPix Panoramabildern bieten sich 2 Möglichkeiten: einerseits die 

Darstellung über das iPix-Image, andererseits über den iPix-Java-Viewer.  

 

Für das iPix-Image ist das iPix-Plug-in, welches unter 

„http://www.ipix.com/support/download/plugin.shtml“ downgeloadet werden kann, 

notwendig. Die Installationsdatei ist ca. 800 kB groß. Man erhält dadurch eine bessere 

Bildqualität und eine höhere Drehgeschwindigkeit. Die Bildvorschau ist ähnlich der 

Quicktime Technologie. Zuerst werden die Bildinhalte unscharf angezeigt, navigieren ist 

bereits möglich. Mit Fortschritt des Ladevorgangs wird das Bild detaillierter. 

 

Will man das iPix-Plug-in nicht in Anspruch nehmen, so hat man die Möglichkeit den 

iPix-Java-Viewer zu verwenden. Die iPix-Dateien müssen jedoch stark komprimiert sein 

(Compression: Internet), eine höhere Qualität ist im iPix-Java-Viewer nicht möglich. Für 

die Betrachtung muss Java installiert und aktiviert sein. Auch hier werden die Bildinhalte 

und das Java-Applet geladen und erst nach Vervollständigung ist das Panorama 

benutzbar. 

 

Die Möglichkeit Sound und Hotspots einzusetzen bieten beide Lösungen. Dies wird über 

die Hotmedia Software und ein zusätzliches Java-Applet realisiert. Der User benötigt 

aber keine weitere Software, um diese Erweiterung nutzen zu können. (vgl. Jacobs, 

2003, S. 176, 198) 

 

5.3.1 Einbindung in HTML 

 

iPix-Plug-in Variante: 

 

Auch hier gibt es bei Verwendung des netscapespezifischen EMBED Tags im Internet 

Explorer in den Versionen 5.5 und 6.0 Darstellungsprobleme. Deshalb sollte zusätzlich 

das OBJECT Tag verwendet werden. (vgl. Jacobs, 2003, S. 176) 

 

<OBJECT ID="IpixX1" WIDTH=320 HEIGHT=240  

CLASSID="CLSID:11260943-421B-11D0-8EAC-0000C07D88CF"  

CODEBASE="http://www.ipix.com/download/ipixx.cab#version=6,2,0,5"> 

<!-- For MSIE 3+ -->  
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<PARAM NAME="IPXFILENAME" VALUE="yourimage.ipx">  

<!-- For Netscape 3+ -->  

<EMBED src="yourimage.ipx" border=0 width=320 height=240 

palette="FOREGROUND" type="application/x-ipix" 

pluginsPage="http://www.ipix.com/cgi-bin/download.cgi"> 

</EMBED>  

</OBJECT> 

 

iPix-Java-Applet Variante: 

 

<APPLET name="IpixViewer"  

code="IpixViewer.class"  

archive="IpixViewer.jar"  

width="320" height="240">  

<PARAM NAME="url" VALUE="YOURIMAGE.ipx">  

<PARAM NAME="toolbar" VALUE="on">  

<PARAM NAME="initfov" VALUE="80">  

<PARAM NAME="spinspeed" VALUE="0">  

<PARAM NAME="spinstyle" VALUE="flat">  

</APPLET> 

 

Parameter Tipps für den Java Viewer 4.0: 

• url: definiert das iPix Bild 

• toolbar: definiert, ob die Navigationsleiste sichtbar sein soll, Default Wert ist „on“. 

• width, height: Breite und Höhe des Panoramafensters 

• spinspeed: automatische Rotation beim Start, Werte zwischen -10 und 10 sind 

möglich, wobei negative Werte eine Drehung nach links und positive Werte eine 

Drehung nach rechst bewirken. Defaultwert ist „0“. 

• spinstyle: Art der Rotation; „flat“ bewirkt eine Drehung in horizontaler Ebene, 

„wave“ eine Drehung in vertikaler Richtung. 

• splash: Vorschaubild im JEPG oder GIF Format 

• helpurl: iPix-Hilfeseite für den Javaviewer, Defaultwert ist: 

„http://www.ipix.com/help/viewalways_java3_2/“ 

(vgl. Jacobs, 2003, S. 178) 
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5.4 Hotmedia 
 

Hotmedia ist ein von IBM entwickeltes Java-Applet für die Darstellung von Panoramen, 

Objectmovies und virtuellen Rundgängen. Auch hier ist erforderlich, dass Java installiert 

und aktiviert ist. Mit der Hotmedia Software lassen sich weitere Medien wie Sound, 

Bilder, Objekte und Videos einbinden. Hotspots werden rot umrandet dargestellt und 

können bei Mouseover einen Text einblenden. Das Panorama ist erst sichtbar und 

navigierbar, wenn der Ladevorgang der Bildinhalte mit dem Hotmedia-Applet 

abgeschlossen ist. 

 

5.4.1 Einbindung in HTML 

 

<APPLET 

code=“hm35.class“ 

name“HotMedia“ 

width=“400“ 

height=“300“ 

<param name=“mrvfile“ value=“parameter.mvr“> 

</APPLET> 

(vgl. Jacobs, 2003, S. 179, 198f) 

 

5.5 VRML Viewer 
 

Virtual Reality Modeling Viewer, kurz VRML, ist eine Skriptsprache, bzw. eine HTML-

Erweiterung, die es erlaubt dreidimensionale Szenen darzustellen. Für die Darstellung 

der Szene benötigt man einen geeigneten Browser oder ein Plug-in für einen der 

Standardbrowser. Standard auf diesem Sektor ist der Cosmo-Player, der als Plug-in für 

Netscape Communicator bzw. den Internet Explorer geeignet ist. 9 

Weitere Player sind der VRML Cortona-Player und der VRML Blaxxun Contact. 

 

VRML wird hauptsächlich für Visualisierung von virtuellen Welten und 3D Daten 

verwendet, doch auch Panoramen lassen sich darstellen. VRML-Viewer arbeiten mit der 

kubischen Projektion, die Einzelbilder des Panoramas müssen als Würfelseiten 

abgespeichert werden.  
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Im Panorama kann während des Downloads navigiert werden. Die bereits geladenen 

Würfelseiten werden angezeigt. Zusatzfunktionen, wie Sound und Startview lassen sich 

über die VR Modeling Language programmieren. Die VRML-Viewer unterstützen 

fotografisch aufgenommene Objekte und 3D-generierte Objekte. Bei diesen 3D-

Renderings kann der Betrachter oftmals Eigenschaften, wie Farbe, Größe und 

Bewegung der Objekte selbst ändern. (vgl. Jacobs, 2003, S. 182, 199) 

 

5.5.1 Einbindung in HTML mit dem Cortona Viewer 
 

<OBJECT 

classid=“clsid:86A88967-7A20-11d2-8EDA-00600818EDB1“ 

codebase=http://www.parallelgraphics.com/bin/cortvrml.cab#Version=4,0,0,76 

width=”400” 

height=”300”> 

<param name=”src” value=”panorama.wrl”> 

<param name=”vrml_background_color” value=”#000000”> 

<param name=”vrml_dashboard” value=”true”> 

<param name=”vrml_splashscreen” value=”true”> 

<param name=”contextmenu” value=”true”> 

<EMBED src=”panorama.wrl” 

width=”400” 

height=”300” 

vrml_splashscreen=”true” 

vrml_dashboard=”true” 

vrml_background_color=”#000000” 

contextmenu=”true” 

type=”x-world/x-vrml” 

pluginsPage=”http://www.parallelgraphics.com/products/cortona”> 

</EMBED> 

</OBJECT> 

(vgl. Jacobs, 2003, S. 182ff) 
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5.6 Flash Panorama 
 

Mit spezieller Software, z.B. „360 Flash Panorama Viewer“, lässt sich ein JPEG-

Panoramabild in ein Flash-Panorama (Shockwave Datei) wandeln. Dabei kann man 

entscheiden, ob die Standardnavigationsleiste oder eine selbst generierte Navigation 

verwendet werden soll. Für die Betrachtung im Browser ist das Flash-Plug-in  

notwendig. 10 

 

Einige Softwareprodukte unterstützen den Export von Flashpanoramen. Mit „qtvr2flash“ 

lässt sich ein fertiges QTVR-Movie in ein Flash-Panorama verwandeln. 11 

 

Der Vorteil von flashgenerierten Panoramen besteht darin, dass man hier komplett auf 

das Quicktime Plug-in verzichten kann und stattdessen das weiterverbreitete Flash Plug-

in verwendet. 

 

5.7 Vergleich der Viewer 
 
Funktionen Quicktime 6.0 Cortona 

Player 4.1 

iPix Player 

6.2 

iPix Java 

Viewer 4.0 

Hotmedia 3.5 PTViewer 2.1 

Viewer-Typ Plug-in / 

ActiveX 

Plug-in / 

ActiveX 

Plug-in / 

ActiveX 

Java Java Java 

Stand-alone-

Player 

Ja Ja Ja Nein Nein Ja (mit der 

Stand-alone-

Version 0.4) 

Verwendungs -

form 

Panorama, 

Objectmovies 

Panorama, 

Objectmovies 

Panorama Panorama Panorama, 

Objectmovies 

Panorama, 

Objectmovies 

Projektionsform Zylindrisch, 

kubisch 

Kubisch Sphärisch Sphärisch Zylindrisch, 

sphärisch 

Zylindrisch, 

sphärisch, 

kubisch 

Zoom Ja Ja (allerdings 

nicht bei 

Panoramen) 

Ja Ja Ja Ja 

Hotspots Ja Nein Ja (über 

Hotmedia) 

Ja (über 

Hotmedia) 

Ja Ja 

Autorotate Ja Nein Ja Ja Ja Ja 

Integrierbarkeit 

anderer Medien 

Sound, Video, 

Bilder 

Sound (über 

VRML) 

Sound 

(über 

Hotmedia) 

Sound (über 

Hotmedia) 

Sound, Video, 

Bilder 

Sound, Video, 

Bilder 

Navierbarkeit 

während der 

Ladezeit 

Ja Ja Ja Nein Nein Nein 

Tabelle 4: Tabellarischer Vergleich der Viewer 
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6. Produktion von Panoramen 
 

6.1 Produktion eines virtuellen Rundgangs 
 

Für die Produktion eines virtuellen Rundgangs werden mehrere Panoramen miteinander 

verlinkt. Die Lage der einzelnen Szenen soll anhand einer Grundrisskarte 

veranschaulicht werden. Der Rundgang soll insgesamt drei Panoramen beinhalten: ein 

zylindrisches nach der Singlerow-Methode, ein weiteres nach der Multirow-Methode und 

ein sphärisches Panorama, mit Hilfe zweier Fisheye-Bildern.  

Für die Ausgabe eines virtuellen Rundgangs bieten sich verschiedene Lösungen an. Die 

am verbreitesten Techniken sind die Verbindung innerhalb der Quicktime VR Struktur 

und die Verlinkung durch ein Java-Applet. Hier soll die Java-Applet Lösung aufgezeigt 

werden. 

 

Die einzelnen Panoramen werden in unterschiedlichen Programmen gestitcht und als 

Panorama-Bildstreifen exportiert. Der virtuelle Rundgang selbst wird im Tourweaver von 

Easypano verwirklicht. Das Endprodukt ist ein Java-Applet, das einerseits die Navigation 

der Panoramen übernimmt und andererseits die Hotspots und Verlinkungen steuert. 

 

Die verwendeten Einzelbilder für die Erzeugung der Panoramen werden der 

Buchbeilagen CD-ROM (JACOBS, C.: Digitale Panoramen, Springer Berlin, 2003) 

entnommen. 

 

Folgende Arbeitsschritte sind daher durchzuführen: 

1. Erzeugung eines zylindrischen Panoramas (Singlerow-Methode) 

2. Erzeugung eines zylindrischen Panoramas (Multirow-Methode) 

3. Erzeugung eines sphärischen Panoramas (mit zwei Fisheye-Bildern) 

4. Verknüpfen der Panoramen zu einem virtuellen Rundgang 

 

6.1.1 Erzeugung eines zylindrischen Panoramas (Singlerow-Methode) 

 

Das erste Panorama besteht aus einer einzelnen Bildreihe mit 14 Einzelbildern. Die 

Produktion geschieht im „Panorama Maker 3.5“ von ArcSoft. Diese Software ist ein 

einfach zu bedienendes Programm, mit dem auf unkomplizierte Weise ein nahtloses 
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Panorama erzeugt werden kann. Eine Demo Version steht unter 

„http://www.arcsoft.com/en/products/panoramamaker“ zur Verfügung. 

 

Auf der Startseite lässt sich einstellen, ob man horizontale, vertikale oder 360° 

Panorama stitchen will. Die Größe der Kameralinse (automatische Erkennung, oder 

bestimmter Wert) und die Ausgabegröße (Klein, Mittel, Groß) lassen sich ebenfalls 

definieren. Es kann ohne Probleme eine große Ausgabe gewählt werden, da 

nachträglich die Verkleinerung in einem Bildbearbeitungsprogramm schnell durchführbar 

ist.  

Mit dem Kontrollkästchen „Automatische Belichtungskorrektur“ ändert Panorama Maker 

die Bildfarben, wenn die Bilder unterschiedliche Helligkeit aufweisen. Das Ergebnis ist 

ein qualitativ besseres Panorama. Diese Funktion kann jedoch auch deaktiviert werden. 

 

Die nächste Bildschirmansicht ermöglicht die Auswahl der Bilddateien. Über „Erfassen“ 

lassen sich Fotos direkt über den Scanner einlesen. Mit „Foto bearbeiten“ lassen sich 

Helligkeit, Kontrast, sowie Drehung nachjustieren. Diese Fotobearbeitungen sollten 

jedoch grundsätzlich im Vorhinein in einem Bildbearbeitungsprogramm getätigt werden, 

da die Panorama Software nur wenige Tools zur Verfügung stellt. 
 

 

Bild 22: Einzelbildimport 
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Im nächsten Schritt werden die Bilder voll automatisch gestitcht. Das Ergebnis, der 

Panoramastreifen, ist nach wenigen Sekunden sichtbar. Die Option „Automatisches 

Zuschneiden“ entfernt die unebenen Kanten des Panoramas. 

Ist das Ergebnis nicht zufrieden stellend, so kann manuell nachbearbeitet werden. Dies 

geschieht über das Tool „Verfeinern“. Es wird ein Fenster geöffnet, in dem die Stitching-

Punkte der Überlappungsbereiche angezeigt werden. Nun kann man diese Punkte in 

beiden Bildern selbst wählen. Mit „OK“ wird die Änderung übernommen und anhand der 

manuell gesetzten Markierungspunkte erneut gestitchet. 

 

 

Bild 23: Manuelles Stitchen mit Hilfe gesetzter Stitching-Punkte 

 

Das nun entstandene Panoramabild kann in einem Preview betrachtet werden. 

Exportieren lässt sich das Projekt entweder als Quicktime VR Movie, oder als Flash 

Movie, dass in einer HTML Seite eingebunden ist. Für die Produktion eines virtuellen 

Rundgangs auf Java-Basis wird jedoch das Panoramabild als Bilddatei benötigt. Der 

Export ist in den gängigen Grafikformaten, wie jpg, tif, bmp, usw. möglich. 
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Vorteile: 

• Das Programm bietet eine sehr einfache und übersichtliche Bedienung. 

• Das Stitching Ergebnis ist außerordentlich gut. Es gibt keine Probleme mit 

Helligkeitsunterschiede an den Überlappungsstellen, da die Software diese 

automatisch bereinigt. Wurde über 360° hinaus fotografiert, so schneidet die 

Software automatisch die überflüssigen Randbereiche ab. 

• Man kommt schnell zum gewünschten Ergebnis. 

• Die Panoramabilder können als Quicktime Movie und Flash Pix exportiert 

werden. 

• Mit rund US $ 40,- ist die Software äußerst günstig. 

 

Nachteile: 

• Panorama Maker bietet wenige Einstellmöglichkeiten. Das Stitchen selbst lässt 

sich fast überhaupt nicht beeinflussen. Lediglich die Stitching Punkte können 

manuell nachjustiert werden. 

• Nur zylindrische Singlerow Panoramen sind möglich. 

(vgl. Bedienungsanleitung Panorama Maker 3.5) 

 

6.1.2 Erzeugung eines zylindrischen Panoramas (Multirow-Methode) 

 

Realviz Stitcher 3.5 ist ein professionelles Stitching Programm, das die Singlerow- und 

Multirow-Methode unterstützt. Es werden sowohl zylindrische, sphärische, als auch 

kubische Projektionen unterstützt. 

Unter „http://www.realviz.com/downloads/st4.php“ lässt sich eine Trial Version 

downloaden. 

 

Ein neues Projekt wird unter „File>New“ angelegt. Die Einzelbilder werden unter 

„File>Load“ Images importiert und scheinen als Thumbnails im unteren Bereich des 

Softwarefensters auf. Realviz erkennt selbstständig die Bildgröße und errechnet 

automatisch Objektivbrennweite und Verzeichnungen. Eine manuelle Veränderung der 

Einstellungen kann über „Edit>Properties“ erledigt werden. 

 

Das Zusammenfügen der Bilder erfolgt manuell. Die Thumbnails werden mittels 

Drag&Drop vom unteren Fenster in das Hauptfenster gezogen. Das Programm 

positioniert die Bilder perspektivisch richtig. 
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Bild 24: Zusammenfügen der Einzelbilder 

 

Per Maus kann grob positioniert werden. Die Feinjustierung erfolgt am besten mit den 

Pfeiltasten der Tastatur, mit der gedrückten Shifttaste kann das Bild gedreht werden.  

Als Orientierung sollte vor allem der äußerste Bereich des zu stitchenden Bildes dienen. 

Schafft man hier gerade lange Linien deckungsgleich übereinander zu bringen, so erhält 

man das beste Ergebnis. 

Sind die Bilder richtig positioniert, so wird mit der Return Taste bestätigt und das 

Programm stitcht die beiden Einzelbilder. 

 

Über die Funktion „Stitch>Adjust All Images“ optimiert die Software die Brennweite 

anhand der bereits gestitchten Bilder. Diese Korrektur sollte nach jeweils 4-5 Bildern 

geschehen. Ist eine Reihe fertig, so wird das Panorama mit „Stitch>Close Panorama“ 

geschlossen. Nun vervollständigt man die nächste Reihe. 

 

Weisen die Einzelbilder leichte Helligkeitsunterschiede auf, so kann die Software diese 

mit „Render>Equalize All Images“ korrigieren. Für starke Unterschiede ist ein 

Bildbearbeitungsprogramm zweckmäßiger. Generell sollte jedoch schon bei der 

Aufnahme auf nicht allzu große Helligkeitsunterschiede geachtet werden. 
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Für die Auswahl des späteren Bildausschnitts wird die Ansicht im Bearbeitungsfenster 

herangezogen. Mit „View>Pan“ und „View>Roll“ lässt sich die Ansicht einstellen. Bevor 

man rendert, kann der Panoramastreifen kontrolliert werden: „Redner>Set Redner 

Area>Cylindrical“. Befinden sich ungewünschte Bildbereiche im Panorama, so sollte die 

Ansicht weiter verändert werden. 

 

Realviz Stitcher unterstützt zylindrische, sphärische und kubische Projektion. Es kann 

ein fertiges Quicktime Movie, oder ein Bildstreifen exportiert werden. Unter „Export 

Format > Type“ wird das Projektionsformat gewählt. Für ein zylindrisches QuicktimeVR 

Movie benötigt man die Einstellung „Cylindrical QTVR“. Resolution legt die Größe des 

Panoramabildes in Pixel fest. 

 

 

Bild 25: Rednereinstellungen 

 

Die Quicktime Einstellungen sind in „Options“ festgelegt. Hier kann der Kompressions 

Codec und die Qualität definiert werden. Die Größe des Ausgabefensters in Pixel und 

der Bildausschnitt beim Start des QTVR Videos lassen sich unter „Window, Pan und Tilt“ 

einstellen. „FOV“ legt den minimalen und maximalen Zoomfaktor fest. „Rendering 

Quality“ bestimmt die Qualität während der Bewegung („Motion“) und beim Standbild 

(„Static“). Beim Export von Cubic QTVR gibt es die Möglichkeit das Panoramabild in 
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quadratische Stücke (Tiles) zu unterteilen, so dass während des Downloads die bereits 

geladenen Tiles abgespielt werden können. 

Sollen Zusatzinformationen über Autor und Copyright hinzugefügt werden, so kann dies 

unter „Annotations“ erledigt werden. 

(vgl. Jacobs, 2003, 84ff) 

 

 

Bild 26: QTVR Output Einstellungen 

 

Vorteile: 

• Es werden alle gängigen Projektionsformen unterstützt. 

• REALVIZ bietet vielfältige Möglichkeiten für den Export. 

• Helligkeitsunterschiede werden sehr gut ausgeglichen. 

 

Nachteile: 

• Die Software unterstützt keine Fisheye Formate. 

• Bei zu großer Überlappung (45% und mehr) kann es Probleme beim Stitchen 

geben. 

• Vor allem bei mehrreihigen Panoramen ist das manuelle Stitchen sehr 

zeitaufwändig. 
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6.1.3 Erzeugung eines sphärischen Panoramas (mit zwei Fisheye-Bildern) 
 

Mit der Software „Panoweaver 3.01“ von Easypano lassen sich sphärische Panoramen 

aus Fisheye-Bildern erzeugen. Panoweaver unterstützt als Input bisher nur ganz runde 

Fischaugenbilder, im Format gif, jpeg, tif, png, tga, bmp. 

Unter „http://www.easypano.com/de/products.htm“ lässt sich eine Demoversion der 

Software downloaden.  

 

Zu aller erst sollten ungewünschte Artefakte, zum Beispiel das Stativ, aus den Bildern 

entfernt werden. Dies lässt sich am besten im Adobe Photoshop erledigen.  

 

    

Bild 27: Entfernen störender Artefakte im Adobe Photoshop 

 

Vor allem bei gleichmäßigen Fußböden (Marmor, Asphalt, Teppich, usw.) können die 

störenden Elemente mit dem Kopierstempel leicht entfernen. Die sauberen Stellen 

werden kopiert und über die Artefakte gezeichnet. Es werden also bereits vorhandene 

Bilddaten auf die zu entfernenden Stellen gelegt. 

 

Panoweaver unterstützt sowohl sphärische, als auch kubische Projektionsformen. Diese 

sind unter „Panorama>Sphärisch/Kubisch Umwandlung“ wählbar. 

 

Helligkeits- und Kontrastunterscheide können unter „Bild>Bild bearbeiten…“ korrigiert 

werden. 

 

Der für den Stitchingprozess relevante Bildausschnitt wird zunächst vorgeschlagen, kann 

aber über die x-y-Koordinaten und den Radius manuell nachjustiert werden. 
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Folgende Outputgrößen sind wählbar: 

• WWW Modem, 1400x700 Pixel 

• DSL Breitband, 2000x1000 Pixel 

• CD Publikation, 3000x1500 Pixel 

• Benutzerdefiniert 

 

Die zwei Fisheye-Bilder werden nach der notwenigen Bearbeitung zunächst automatisch 

gestitcht. Ob das Ergebnis wirklich in Ordnung ist, lässt sich am besten im sphärischen 

Modus überprüfen, da man hier den gesamten Bildstreifen zu sehen bekommt. Ist man 

mit dem Stitching Ergebnis nicht zufrieden, hat man die Möglichkeit manuell zu stitchen. 

Zwei Vorschaufenster (Hemisphäre vorne und hinten) zeigen die Überlappungsbereiche 

der beiden Bilder. Durch Veränderung der Einstellungen „FOV, Yaw, Pitch und Roll“ lässt 

sich der Nahtschluss beliebig einstellen. 

 

 
Bild 28: Manuelles Justieren der Nahtstellen 

 

Ist man mit dem Stitching Ergebnis zufrieden, so kann das Panorama exportiert werden. 

Der Bildstreifen lässt sich in den gängigen Grafikformaten (jpg, png, bmp, psd und tga) 

speichern. Panoweaver exportiert aber auch direkt die Formate QTVR, PT-Viewer und 

VRML. 
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Bild 29: Exporteinstellungen 

 

Beim Export eines QTVR Movies lässt sich über die „Viewer Parameter“ die 

Ausgabegröße und die Zoom-Ansicht beim Start des Movies einstellen. Als einziger 

Kompressions-Codec wird der JPEG Codec unterstützt, bei dem die Qualität wählbar ist.  

(vgl. Bedienungsanleitung Panoweaver 3.01) 

 

Vorteile: 

• Die Software bietet eine sehr leichte und verständliche Benutzung. Mit wenigen 

Arbeitsschritten erreicht man ein gutes Stitching Ergebnis. 

• Vielfältiger Export in den Formate QTVR, PT-Viewer und VRML. 

 

Nachteile: 

• Es werden nur Fisheye Bilder unterstützt. 

• Als QTVR Compressions-Codec wird lediglich der JPEG-Codec verwendet. 

• Bei der manuellen Stitching Methode hat man wenige Einstellmöglichkeiten. 

 

6.1.4 Verknüpfen von Panoramen zu einem virtuellen Rundgang 

 

Ein sehr schönes Tool zur Gestaltung von virtuellen Rundgängen ist der Tourweaver 

1.25 von Easypano. Eine Demoversion der Software kann unter 

„http://www.easypano.com/de/productsTW.htm“ downgeloadet werden.  
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Das Endergebnis des Projekts ist eine Hotspot-Verknüpfung von mehreren Panoramen. 

Die Lage der einzelnen Szenen wird auf einer Karte angezeigt, die man direkt anwählen 

kann. Die Viewertechnik ist ein Java-Applet, das auf die jpg-Panoramabilder zugreift und 

alle Navigationen steuert. 

 

Beim Projektstart kann entweder eine vorgefertigte Oberfläche, oder ein leeres 

Dokument ausgewählt werden. Die Vorlagen beinhalten bereits alle wichtigen Tools und 

können farblich nachträglich im Bereich „Oberfläche“ angeglichen werden. Hier werden 

alle benötigten Elemente positioniert, die später im Viewerfenster sichtbar sein sollen. 

 

Im Menüpunkt „Verwalten“ können die Panoramabilder in das Projekt geladen werden. 

Hier wird unterschieden zwischen zylindrischen und sphärischen Panoramen, sowie 

Standfotos und One-Shot Lösungen. Die einzelnen Panoramen müssen in jpg, gif oder 

bmp Formaten vorliegen. Für Webanwendungen empfiehlt sich eine Dateigröße von 

jeweils 500 kB nicht zu überschreiten, da sonst eine flüssige Wiedergabe nicht 

gewährleistet werden kann. 

 

Unter „Szene“ wird der Blickausschnitt beim Start des Movies konfiguriert. Zusätzlich 

kann über „Szenen Sound“ Hintergrundmusik in die Szene integriert werden. Für den 

Wechsel zwischen den Panoramen lassen sich verschiedene Übergangseffekte 

einstellen. Eine Kurzinformation über die Szene lässt sich unter „Szenenbeschreibung“ 

verfassen, die im Viewerfenster angezeigt wird.  

 

Im nächsten Bereich werden Hotspots definiert. Die Panoramen werden nun 

untereinander verlinkt. Für den Hotspot selbst kann auch ein eigenes Bild, z.B. ein Pfeil, 

verwendet werden. Das Zusammenspiel der einzelnen Szenen wird in der Hotspot Karte 

verdeutlicht und dient als Kontrolle. Zusätzlich gibt es die Möglichkeit Klang-, HTML- und 

Sequenz-Hotspots zu definieren. Sequenzen spielen eine vorgefertigte Diashow ab, 

diese kann im nächsten Programmpunkt festgelegt werden.  

 

Unter „Karte“ lädt das Programm einen Grundrissplan des Projekts. Die verwendeten 

Panoramen werden nun auch auf dieser Karte mittels Hotspots-Verlinkungen platziert 

und können direkt angesteuert werden. Sind alle Einstellungen getroffen, wird das 

Projekt exportiert. Die Software erzeugt eine HTML-Seite, in die ein Java-Applet zur 

Steuerung der Elemente eingebettet ist. (vgl. Bedienungsanleitung Tourweaver 1.25) 
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Bild 30: Virtuelle Tour produziert im Tourweaver 

 

Vorteile: 

• Das Programm bietet eine übersichtliche Oberfläche und ist leicht zu bedienen. 

• Die Größe der einzelnen Panoramen kann selbst bestimmt werden, d.h. 

Tourweaver verändert die verwendeten Bilddateien nicht. Das Java-Applet greift 

immer auf die Orginaldateien zu. 

• Schönes Endprodukt, dass lediglich das Java Plug-in benötigt. 

• Es sind keine Programmierkenntnisse notwendig. 

• Das Layout der virtuellen Tour kann beliebig verändert werden. 

• Durch die Integration von Sequenzen und Sound-Hotspots wird die Interaktivität 

erhöht. 

 

Nachteile: 

• Der Export ist nur als Java-Applet möglich, andere Formate werden nicht 

unterstützt. 

• Bestehende QTVR Movies und QTVR Objectmovies können nicht integriert 

werden. 
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6.2 Produktion eines Objectmovies 
 

Mit der Software VR Works 2.5.3 lassen sich Singlerow- und Multirow-Objectmovies 

erzeugen. Eine Demo Version der Software lässt sich unter 

„http://www.vrtoolbox.com/vrworx25.html“ downloaden. Für die Produktion von Multirow-

Objectmovies ist die Bezeichnung der Einzelbilder sehr wichtig.  

 

Es soll ein Rundum-Movie einer Armbanduhr erzeugt werden. In diesem Fall sind 7 

Reihen zu je 36 Bildern, d.h. insgesamt 252 Einzelbilder notwendig. Die einzelnen 

Bildreihen haben einen vertikalen Abstand von 30°. Die verwendeten Bilder für die 

Erzeugung des Movies werden der Buchbeilagen CD-ROM (JACOBS, C.: Digitale 

Panoramen, Springer Berlin, 2003) entnommen. 

 

Die folgende Tabelle gibt eine Übersicht der Bildnamen in den einzelnen Reihen: 

 

Reihe Ausrichtung Benennung 

1 + 90° 001 – 036 

2 + 60° 037 – 072 

3 + 30° 073 – 108 

4 +/- 0° 109 – 144 

5 - 30° 145 – 180 

6 - 60° 181 – 216 

7 - 90° 217 - 252 

Tabelle 5: Einzelbildbezeichnungen 

 

Mit „File>New“, „Create an Object“ startet man ein neues Projekt. 
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Bild 31: Setup Einstellungen 

 

Zunächst wird die Bildergröße über „Image Size“ bestimmt. Über „Source“ können 

alternative Bildquellen, wie Scanner, Videokarte, usw. angegeben werden. Im Bereich 

„Object Geometry“ werden Angaben über die Bilderreihen getätigt. „Horizontal Settings“ 

gibt die Anzahl der Bilder in horizontaler Richtung an, „Sweep“ bestimmt den 

Abbildungsumfang. Singlerow-Movies haben unter „Vertical Settings“ einen „Sweep“ von 

0°, Rundum-Multirow-Movies haben einen Wert von 180°. 

 

Sind alle Einstellungen getroffen, wechselt man in den Bereich „Acquire“, in dem die 

Bilder geladen werden. Über „Image>Multiple“ lädt man alle Einzelbilder in das Projekt. 

 

Im Bereich „Effects“ lässt sich die Ausgangsposition, also die erste Ansicht beim Start 

des Movies, bestimmen. 
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Bild 32: Ausrichtung des Objekts 

 

Diese Funktion ist hilfreich, wenn das Objekt nicht in der Bildmitte der Aufnahme ist. Mit 

„Crop“ kann man den späteren Bildausschnitt beschneiden. „Dewobble“ ist eine 

Funktion, mit der sich nicht ganz mittig aufgenommene Bilder korrigieren lassen. Mit 

„Matte“ hat man die Möglichkeit das Objekt vom Hintergrund freizustellen und einen 

neuen einzufügen. Dies kann eine ganz normale Farbfläche, aber auch ein QTVR-Movie 

sein. Über „Sound“ lassen sich eine oder mehrere Soundspuren in das Projekt 

einbinden. 

 

Im Bereich „Compose“ wird der Kompressions-Codec und dessen Qualität für das 

exportierte QTVR Movie bestimmt. Sind alle Einstellungen getroffen, wird mit „Build“ der 

Stitching Vorgang gestartet. Das fertig gerenderte Movie kann im „Playback“-Fenster 

getestet werden. Die endgültige Fenstergröße wird mit „Playback Window“ bestimmt. 

Über „Annotate“ können Zusatzinformationen über Name, Copyright und Inhalt getroffen 

werden. Die Maus- und Tastenfunktionen können mit „Interaction“ beeinflusst werden. 

(vgl. Jacobs, 2003, S. 141ff) 

 



64 

Vorteile: 

• Die Software bietet eine einfache Bedienung. 

• Durch umfangreiche Korrektur- und Effektfunktionen erhält man ein gutes 

Stitching Ergebnis. 

• Die Software unterstützt die TWAIN-Schnittstelle, mit der gescannte Bilder direkt 

in das Projekt geladen werden können. 

 

Nachteile: 

• Ein VR Works Dokument integriert alle Einzelbilder in das Projekt, so dass die 

Datei entsprechend groß ausfällt (200 MB und mehr). 
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6.3 Vergleich der Software 
 
Funktionen Panorama 

Maker 

Realviz Stitcher VR Works Panoweaver Tourweaver 

Website www.arcsoft.com www.realviz.com www.vrtoolbox.com www.easypano.com www.easypano. 

com 

Plattform Mac, Win Mac, Win Mac, Win Mac, Win Mac, Win 

Preis $ 39,99 € 499 $ 299 € 279,95 € 459,95 

Verwendungs -

form 

Panoramen Panoramen, 

Objectmovies, 

virtuelle 

Rundgänge 

Panoramen, 

Objectmovies, 

virtuelle 

Rundgänge 

Panoramen virtuelle 

Rundgänge 

Stitching 

Technik 

Singlerow  Singlerow, 

Multirow  

Singlerow  Singlerow, Multirow  

(Fisheye) 

- 

Objektivtypen rechtwinkelig 

abbildende 

rechtwinkelig 

abbildende und 

Fisheye 

rechtwinkelig abbil-

dende und Fisheye 

Fisheye - 

Korrektur von 

Abbildungs-

fehlern 

Ja Ja Ja Ja - 

Importformate bmp, tif, pcx, gif, 

tga, fpg, pcd, fpx  

bmp, jpg, png, 

pict, ppm, tif 

bmp, jpg, psd, pict, 

png, sgi, tga, tif  

gif, jpg, tif, tga, bmp, 

png 

jpg, bmp, gif 

Exportformate bmp, tif, pcx, gif, 

tga, jpg, fpx  

bmp, jpg, png, 

psd, tif  

bmp, jpg, psd, pict, 

png, sgi, tga, tif  

psd, jpg, tga, bmp, 

png 

- 

Projektions-

formate 

zylindrisch plan, zylindrisch, 

sphärisch, 

kubisch 

zylindrisch sphärisch, kubisch - 

Umwandlung 

von Projektions-

formaten 

Nein Ja Ja Ja - 

Panorama-

formate 

Flash Movie, 

QTVR 

Cylindrical, 

QTVR, VRML, 

Live Picture Java 

QTVR PT Viewer, Realtime 

VR (Java Applet), 

QTVR 

Java Applet 

Tabelle 6: Vergleich der Software 
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7. Anwendungsgebiete im Web 
 

7.1 Architektur 
 

Alleine für Planungs- und Präsentationsanwendungen bieten Panoramen vielfältige 

Möglichkeiten. So kann zum Beispiel ein geplantes Gebäude in einem 3D Programm 

erstellt werden. Aus verschiedenen Blickwinkeln (Vorderansicht, Innenräume, …) werden 

Bilder exportiert, die zu Panoramen gestitcht werden. Durch Verknüpfung dieser, kann 

bereits vor Baubeginn ein realistischer Rundgang erzeugt werden. 

Objectmovies von Gebäuden geben einen Rundblick und ersparen eine Anhäufung von 

Einzelansichten.  

 

 

Bild 33: Panoramadarstellung eines Gebäudes, produziert mit einer 3D-Software 

 

Auch für Dokumentationszwecke während des Baus können Panoramen eingesetzt 

werden. Da man bei der herkömmlichen Fotografie durch einen bestimmten Blickwinkel 

eingeschränkt ist, sind diese Verfahren für eine neutrale Darstellung von räumlichen 

Situationen weniger geeignet. Eine Panoramadarstellung bietet hier eine gute 

Alternative. (vgl. Jacobs, 2003, S. 203) 

 

7.2 Tourismus / Kultur 
 

Städte präsentieren sich gerne in Panoramen. Sowohl Einzelansichten, als auch virtuelle 

Touren durch eine Stadt sind sehr gefragt. Sinnvoll erscheint hier die Verwendung eines 
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Stadtplans, wo der derzeitige Standort der Tour aufscheint. Durch einen gezielten Klick 

auf der Karte, springt man zum gewünschten Panorama. Bei QTVR Movies ist auch die 

Integration von Soundspuren möglich, wodurch realistische Hintergrundgeräusche 

abgespielt werden können. Hotspots mit Hyperlinks weisen zum Beispiel auf Hotels und 

Geschäfte, wodurch ein solches Projekt auch für die Wirtschaft interessant sein kann.  

 

 

Bild 34: Virtueller Stadtrundgang 

 

Besonders reizvoll ist eine Tour durch ein Museum, bei der nicht nur die einzelnen 

Räume realistisch begangen werden können, sondern auch eine Integration von 

Objectmovies sinnvoll ist. So kann man interessante Ausstellungsstücke rundum 

ansehen. Dadurch wird auch die Besichtigung von gefährdeten Stücken, die der 

Öffentlichkeit normalerweise nicht zugänglich sind, ermöglicht. 

 

7.3 Kunst 
 

Eine spezielle Anwendungsform sind Kunstpanoramen. Dabei werden zum Beispiel 

Bilder gestitcht, die eigentlich gar nicht zusammenpassen. Es ergeben sich interessante 

Gebilde, die so in der Realität nie vorkommen könnten. Auch ein Stitchen in den 

normalerweise falschen Perspektiven ergeben interessante Ergebnisse. (vgl. Jacobs, 

2003, S. 203) 
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Bild 35: Kunstpanoramen 

 

7.4 Medizin 
 

Auch in der Medizin finden Panoramadarstellungen von Körperteilen, Gelenken, 

Knochen, usw. eine Anwendung. Sowohl 3D generierte, als auch abfotografierte Objekte 

können rundum betrachtet werden. 
 

 
Bild 36: Objectmovie eines menschlichen Skeletts 
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7.5 Interaktive Karten 
 

Mit dem System „Global Positioning System“ (GPS) können bei der Aufnahme von 

Panoramen die genauen Positionsdaten miterfasst werden. Auf diese Weise entstehen 

so genannte Mapping-Systeme. Dies sind interaktive Karten, bei denen bei jedem 

Panorama zusätzlich die genauen Navigationsdaten angezeigt werden. Mapping-

Systeme sind erweiterte virtuelle Rundgänge, bei denen Integration von Sound, Video, 

Grafiken und GPS-Daten möglich ist. (vgl. Jacobs, 2003, S. 203) 

 

7.6 Produktpräsentationen 
 

Besonders Automobilhersteller haben die Panoramatechnik für sich entdeckt. Sowohl 

Außen- als auch Innenansichten von Autos können sehr informativ und verkaufsfördernd 

wirken. 

 

  
Bild 37: Objectmovies von Außen- und Innenaufnahmen eines Cabrios 

 

Die Einsatzgebiete sind vielfältig, so sind alle Arten der Produktpräsentation von 

technischen Geräten bis hin zu Möbeln vorstellbar. Sogar im Modesektor werden 

Objectmovies von Models erstellt, die auf entsprechend großen Drehtellern 

aufgenommen werden. Shopsysteme im Internet stellen den klassischen 

Anwendungsbereich von Objectmovies dar. Durch Drehung der Artikel regt man beim 

Kunden vermehrtes Interesse und höhere Kaufmotivation an. 
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8. Video VR 
 

8.1 Übersicht 
 

Eine weitere Möglichkeit interaktive Panoramen zu erzeugen sind Videopanoramen. 

Dabei wird als Quellmaterial statt Standbilder, Videobilder verwendet. Der Benutzer 

bekommt einen Ausschnitt des Videos zu sehen und kann darin navigieren. Video VR 

unterstützt zurzeit nur die Quicktime Technologie. (vgl. Jacobs, 2003, S. 205ff) 

 

8.2 Produktion 
 

Für die Aufzeichnung solcher Bewegtbild-Panoramen bieten unterschiedliche Hersteller 

eigene Technologien an. 

 

8.2.1 iMove Spherical Video 

 

Die Fa. iMove Spherical Video hat ein 6-Linsen-Videokamera-System entwickelt, das alle 

Bildbereiche auf einmal erfassen kann. Die sechs Einzelvideos werden mit einer 

speziellen Software zu einem sphärischen Video zusammengefügt. (vgl. Jacobs, 2003, 

S. 205ff) 
 

 
Bild 38: 6-Linsen-Videokamera-System der Fa. iMove 
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8.2.2 iPix 
 

Die Firma iPix (http://www.ipix.com) bietet ein anderes System zur Erzeugung von 

sphärischen Videos an. Hier wird das iPix-typische 8-mm-Fisheye-Prinzip angewandt. 

Mit speziellen Doppel-Fisheye-Objektiven für Videokameras werden zwei Video-

Hemisphären gleichzeitig aufgezeichnet und mit einer speziellen Software 

zusammengesetzt. (vgl. Jacobs S. 205ff) 

 

 

Bild 39: Doppel-Fisheye-Technik von iPix 

 

8.2.3 BeHere Technologie 

 

Die Aufnahmen werden mit einer digitalen Videokamera, kombiniert mit dem BeHere’s 

TotalView 360° Parabolspiegel, erzeugt. Die Kamera wird so positioniert, dass sie 

vertikal in den Spiegel, der an der Frontseite des Kameraobjektivs befestigt wird, filmt. 

Diese Hardware Kombination erzeugt einen Singleshot der kompletten 

Kameraumgebung und speichert die Frames als Donut-Form. Abhängig vom 

gewünschten Output-Format wird das Donut-Bild entweder auf der Kamera direkt 

gespeichert, oder encodiert in Echtzeit für einen Livestream angeboten.  

 

BeHere’s Total View Software konvertiert das Donut-Bild in ein zylindrisches 

Panoramabild und speichert die Sequenz in einem Standardvideoformat. Anders wie bei 

Multishot-Kamera-Systemen ist hier kein Stitchen notwendig, dadurch wird Zeit und Geld 

bei der Produktion gespart. Die Qualität des Videos ist stark abhängig von der Auflösung 

der Kamera. Mehrere Sensoren in den Kamera Chips erzeugen mehr Pixel im 

Originalbild und erhöhen somit auch die Qualität des Endvideos. Das Material kann nun 

entweder in einer Videoedit Software, wie zum Beispiel Adobe Premiere, verarbeitet 

werden, oder in ein Web-Stream-Format, wie Windows Media Encoder, konvertiert 
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werden. Unter Verwendung eines Standard-Streaming-Servers, wie RealNetworks, 

Microsoft oder Apple, lassen sich Bitraten von 56-300 kB und höher bewältigen. Das 

Video wird eingebettet in einer HTML-Seite mit dem BeHere Plug-in angezeigt. 

(vgl. Andrews, 2003, S. 129ff) 

 

 

Bild 40: BeHere’s Video VR Capture Technolgie 

 

8.2.4 Tips bei der Aufnahme von VR Videos 

 

Bei der Aufnahme ist es ratsam darauf  zu achten, dass die Umgebung gleichmäßig 

ausgeleuchtet ist und vor allem, dass kein Licht direkt in das Objektiv scheint. Es sollten 

stets Ereignisse in allen Richtungen der Kameraumgebung stattfinden, damit der 

Benutzer immer etwas Interessantes zu entdecken hat.  

Idealerweise positioniert man die Kamera so nah wie möglich beim Geschehen. 

Die Ausrichtung der Kamera sollte exakt vertikal eingestellt werden, da sonst der 360° 

Effekt nicht zur Wirkung kommt. 
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8.3 Anwendungen 
 

Die Anwendungsgebiete für solche 360°-Videoanwendungen sind vielfältig. Besonders 

bei Aktionen, die in einem Raum gleichzeitig stattfinden, wie Diskussionsrunden, 

Sportereignisse oder Konzerte könnte diese Technologie eingesetzt werden. Bei 

Konzertveranstaltungen lassen sich individuelle Blicke hinter die Kulissen realisieren, die 

dem Betrachter normalerweise verwährt blieben.  

Weitere mögliche Einsatzgebiete sind Musikclips, Werbevideos oder 

Firmenpräsentationen. Hier kann der Betrachter im Video navigieren und immer wieder 

neue Details entdecken. (vgl. Jacobs S. 205ff) 
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9. Ausblicke 
 
Bisher entwickelte Programme sind lediglich in der Lage, Bilder mit gleicher Brennweite 

und Größe zusammen zu fügen. Am Wilhelm-Schickard-Institut für Informatik im Bereich 

Grafisch-Interaktive Systeme der Universität Tübingen wird derzeit eine Software 

entwickelt, die es erlaubt, Bilder unterschiedlicher Brennweite zu stitchen. Außerdem ist 

manuelles Stitchen mit dieser Software nicht erforderlich, da anhand korrespondierender 

Punkte in den Einzelbildern die Überlappungsbereiche korrekt zusammengesetzt 

werden. Informationen über den derzeitigen Entwicklungsstand der Software kann man 

unter „http://www.gris.uni-tuebingen.de/~biber/“ erfahren. (vgl. Jacobs, 2003, S. 205ff) 

 

Die Firma Spheron VR bietet eine neue Kamera- und Viewertechnologie zur Erzeugung 

und Betrachtung von High-Dynamic-Range-Panoramen an. HDR-Panoramen bieten im 

Gegensatz zu normalen Panoramen eine detailiertere Helligkeitsabstufung. So können in 

Schattenbereichen und sehr hellen Bereichen Details erkannt werden. Die 

Lichtverhältnisse ähneln somit sehr den der realen Welt. 12 

 

Objectmovies können seit kurzem statt der Verwendung einer Vielzahl von Einzelbildern, 

aus nur 2 Abbildungen erzeugt werden. Die Software 1-2-3D 

(http://www.motionparallax.com/1-2-3Dinstructions.htm) entwickelt aus den Abbildungen 

automatisch ein computergeneriertes Drahtgittermodell, wobei die Fotos als Textur 

dienen. Das Objekt kann so relativ einfach von allen Seiten betrachtet werden. Hiefür ist 

das VRML-Cortona-Plugin notwendig. (vgl. Jacobs, 2003, S. 206) 

 

 

Bild 41: Fotografie, Generierung und Viewer der Software 1-2-3D 
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